Service Level Manager

Release: 1.0.20
This documentation and any related computer software help programs (hereinafter referred to as the "Documentation") are for your informational purposes only and are subject to change or withdrawal by NIMSOFT at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of NIMSOFT. This Documentation is confidential and proprietary information of NIMSOFT and may not be used or disclosed by you except as may be permitted in a separate confidentiality agreement between you and NIMSOFT.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all NIMSOFT copyright notices and legends are affixed to each reproduced copy.

The right to print copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to NIMSOFT that all copies and partial copies of the Documentation have been returned to NIMSOFT or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NIMSOFT PROVIDES THIS DOCUMENTATION "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL NIMSOFT BE LIABLE TO THE END USER OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF NIMSOFT IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is NIMSOFT.

Copyright © 2010 NIMSOFT. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
Contact Nimsoft

Contact Technical Support

For your convenience, Nimsoft provides one site where you can access the information you need for your Nimsoft products.

At [http://support.nimsoft.com/](http://support.nimsoft.com/), you can access the following:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- Nimsoft Support policies and guidelines
- Other helpful resources appropriate for your product

Provide Feedback

If you have comments or questions about Nimsoft product documentation, you can send a message to support@nimsoft.com.
# Contents

## Contact Nimsoft

### Contents

Updating this documentation ................................................................. 7

## Document History

### Chapter 1: SLM Overview

What is Service Level Management? .......................................................... 9

SLM Concept .............................................................................................. 11

  - Data Collection .................................................................................. 12
  - Data Transport ................................................................................... 12
  - Data Repository .................................................................................. 12

Setting up a Probe to Deliver Quality of Service Data ................................... 13

Troubleshooting ......................................................................................... 14

SLM Database structure ............................................................................. 15

  - QoS data tables .................................................................................. 16
  - SLA configuration tables ................................................................... 17
  - SLA calculation tables ....................................................................... 17
  - Account tables ................................................................................... 18

SLA Engine .................................................................................................. 18

  - Overview ........................................................................................... 18

Data Engine ................................................................................................ 18

  - Defining the Quality of Service Object .............................................. 19
  - Populating the Quality of Service Tables .......................................... 21

The Service Level Manager Application ...................................................... 21

## Chapter 2: Compliance Calculation

Introduction ............................................................................................... 22

Definition of Compliance Percentage ........................................................ 22

Defining the Calculation Terms and Conditions ......................................... 24

  - Calculation Terms and Conditions for the QoS ................................... 25
  - Calculation Terms and Conditions for the SLO .................................... 26
## Contents

| Calculation Terms and Conditions for the SLA | 28 |
| Summary | 29 |
| Definition of Multi-series Calculation | 30 |
| Calculation Examples | 32 |
| Example 1, one QoS and one SLO | 32 |
| Example 2, two QoS’s and one SLO | 33 |
| Example 3, two QoS’s and one SLO, using Calculation method AND or OR | 34 |
| Example 4, two SLOs, each with 3 QoS | 34 |

### Chapter 3: Service Level Manager Reference Guide 37

- The Menu Bar | 38 |
- The Navigation Pane | 44 |
- Service Level Agreements | 45 |
- Operating Periods | 50 |
- Calculation Profiles | 52 |
- Quality of Service | 53 |

- Main Window Pane | 55 |

### Chapter 4: Service Level Manager User Guide 56

- Login | 57 |
- Creating Service Level Agreements | 58 |
- Creating a SLA | 58 |
- Creating a Service Level Objective (SLO) | 71 |
- Defining a Quality of Service object | 81 |
- Defining QoS Constraints | 82 |
- Distributing Importance (weight) | 85 |
- Creating a Compliance period | 86 |
- Creating an Operating Period | 88 |
- Creating a Calculation Profile | 90 |
- Excluding Quality of Service Data | 99 |

### Example - Defining a simple Service Level Agreement 103

- Step 1 – Define an Operating Period | 104 |
- Step 2 – Create a new SLA and Define the Service Level Compliance Requirement | 105 |
- Step 3 – Define the Individual Service Level Objectives | 107 |
- Step 5 – Excluding Periods | 108 |
- Creating a SLA, using the SLA Wizard | 110 |
- Creating a QoS Monitoring Profile | 122 |
- Baseline Value Definition | 124 |
QoS Monitors List.................................................................................................................. 125
QoS Monitor Properties ........................................................................................................ 126
Viewing the Quality of Service (QoS) Data........................................................................ 131
  Generating a Graph............................................................................................................... 132
Exporting the QoS data series ............................................................................................ 134
Exporting QoS data, using Export QoS Data wizard ........................................................ 134
Data Management.............................................................................................................. 140
  Viewing the Actual Database Usage.................................................................................. 140
  Managing your QoS Data................................................................................................. 148
Watching SLA Calculations................................................................................................. 150
Sending SQL Queries to the database ............................................................................... 154

Chapter 5: Appendix ........................................................................................................... 155

SLM Terms and definitions ............................................................................................... 155
Index .................................................................................................................................. 161
Updating this documentation

The documentation system is a set of HTML-files compiled into a single .chm file. You can easily update this documentation by downloading a copy from the support Web here.

- Make sure no On-line help is active, including this one.
- Copy the downloaded file to the ...\Nimsoft\docs directory.
## Document History

<table>
<thead>
<tr>
<th>Date/version</th>
<th>What is new?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 1.00</td>
<td>Created help document for Service Level Manager</td>
</tr>
<tr>
<td>Version 1.0.8</td>
<td>Updated for Phase 2 modifications</td>
</tr>
<tr>
<td>Version 1.0.9</td>
<td>Updated for review comment</td>
</tr>
<tr>
<td>Version 1.0.17</td>
<td>Updated for latest changes</td>
</tr>
<tr>
<td>Version 1.0.20</td>
<td>Updated for latest changes</td>
</tr>
</tbody>
</table>
Chapter 1: SLM Overview

This chapter describes the different components and elements involved in Service Level Management.

What is Service Level Management?

*Service-level management* is the set of people and systems that allows the organization to ensure that SLAs are being met and that the necessary resources are being provided efficiently.

A service level agreement (SLA) is an agreement between a client and a provider of the service. It is vital to the contract and the relationship between the client and the service provider that both parties *identify* and document their service *needs*.

In short, Service Level Management embraces a set of tools to monitor and ensure the validity of a set of SLAs for internal customers (e.g. an IT-department-providing services for a user-department) and external customers. We like to visualize the Service Level Management task as the following hierarchy:

- Service Level Management (SLM)
  - Service Level Agreement (SLA)
    - Service Level Objective (SLO)
      - Quality of Service (QoS)
SLM Overview

Service Level Manager

Probes
Collecting data from different parts of the NimBUS Infrastructure.

QoS data

data_engine
Receives QoS data from the probes and inserts data into the database.

sla_engine
Handles the data inserted into the database by the data_engine. Performs calculations, based on the settings and conditions for the different SLAs and writes the result back into the database.

report_engine
Provides SLA reports, based on calculations performed by the sla_engine.

SLAs consist of one or more SLOs, each with one or more QoS constraints. These components are configured with a set of terms and conditions. Each SLA is assigned a structure in the database.

SLA Reports
SLM Concept

This overview explains the various components of Service Level Management (SLM). Our design principle is to break down the Service Level Agreement (SLA) into smaller components, making it simple to build powerful, extendable and measurable agreements between you and your clients.

The illustration shows the various components that may be contained within a Service Level Agreement. This SLA contains three service level objectives (SLO) that contain one or more constrained Quality of Service (QoS) objects. The QoS is the smallest measurable entity within the SLM, typically a checkpoint value (e.g. CPU usage, Network usage) provided by a Probe capable of sending QoS.

The SLM product is, as stated above, built on the concept of modules. This eliminates the needs to install one big lump of program on your system. The Nimsoft architecture is highly modularised, thus spreading the workload across multiple nodes in your network. Some probes may monitor and report network traffic on one system, while another reports URL response etc.

To build a successful SLM environment we need to understand the areas of:

- Data collection
- Data transport
- Data repository
Data Collection

Data collection is normally performed by task-oriented software (probes) dedicated to monitor and report changes and threshold breaches. A QoS enabled probe, such as the *cdm* (the CPU, Disk and Memory monitoring probe) will generate a Quality of Service message each time it checks its objective, hence giving us the opportunity to gather the collected data and perform various processing techniques on the data.

You may browse the QoS data-series in the Service Level Manager and utilize the same data in your Service Level Objectives.

**NOTE:**
When computers hosting QoS enabled probes are renamed or when moving the monitoring from one machine to another or renaming a machine, the QoS objects will be stored in new tables in the QoS database. To keep your existing data you can merge the existing data with the new data, giving you one table with the full data series (see description of merging QoS objects in the section The Active Objects Tab).

Data Transport

The underlying infrastructure of the transport mechanism is the message-bus. This message-bus is based on high-availability architecture in a multi-platform environment.

Data Repository

One of the key elements of the SLM is the Data Engine; this "engine" subscribes to QoS messages and processes the messages into the database. Currently we support Microsoft SQL Server, over the ActiveX Data Objects (ADO) layer. The Data Engine will timely process the recorded QoS data into the Service Level Objectives and Service Level Agreements according to its configurations.
Setting up a Probe to Deliver Quality of Service Data

Let's configure a probe to generate QoS data while monitoring your system. In this example, we use the *cdm* probe.

Launch the property window of the *cdm* probe of your choice (assuming that you have Nimsoft administrative rights) from the Infrastructure Manager.

The *cdm* probe supports QoS for each disk, CPU, Memory, Paging activity and Processor Queue length. All QoS definitions, except for the disk properties, are located under the *advanced* tab. Check the ones you are interested in.

The QoS definitions for the disk properties are located under the *Status* tab. Double-click the disk you are interested in and check the Disk Usage QoS Message (in Mb and/or %) option in the dialog popping up.
Reply Yes when prompted for a restart.

The probe will initially send a QOS_DEFINITION message to the data_engine causing the SLM system to recognize the new QoS Object.

Please note that this procedure differs from probe to probe.

Troubleshooting

1. The probe has been configured, but no QoS object is recorded in SLM.

   This situation could easily occur if you configured the probe to deliver QoS prior to installing the data_engine. The QOS_DEFINITION message was then ignored, hence not defining the QoS object.

   **Solution**
   Restart the probe (deactivate/activate) or restart the robot
(this is probably the best idea if you have modified the configuration for more than one probe).

2. I've restarted the probe/robot but still no QoS object is present under the QoS nodes.

   **Solution**
   There is probably only some delay in the system, wait a few seconds/minutes and select *update* from the action (popup) menu.

**SLM Database structure**

The tables in the SLM database all have prefixes indicating the type of data it contains.

The name convention for the tables is on the form:

- **S_** for tables used to store system data.
- **D_** for data tables.
- **H_** for tables containing historic data.
- **HN_** for data tables containing historic/compressed data.
- **RN_** for data tables containing unprocessed (raw) data directly from the probes.
**Tips:**

If you want to take a look at the SLA database schema, you can do that by opening the SQL Server Enterprise Manager and select the SLA database node.

This node has a child called *Diagrams*. Select that child and right-click on it.

Select *New Database Diagram*. The *Create Database Diagram Wizard* is started. Follow the instructions in the wizard and select all the tables starting with S_ and D_.

Finishing the wizard will give you the complete database schema for SLA QoS data tables

**QoS data tables**

The QoS data structure is dynamically created by the *data_engine* on the first start-up, and on the first unique *QOS DEFINITION* or *QOS MESSAGE* message received from a probe.

The *S_QOS DEFINITION* table contains the definitions of known QoS types (e.g. *QOS_CPU_USAGE*), and is updated when a probe sends a *QOS DEFINITION* describing a new QoS type.

The *S_QOS_DATA* table contains an index of all data tables for the QoS objects. When a probe sends a *QOS MESSAGE* containing a QoS object that is not already defined in the *S_QOS_TABLE*, a new entry is added to the table and the data is inserted into the table referenced in column *r_table* (typically RN_QOS_DATA_nnnn) with the *table_id* that the new row is given when inserted into the *S_QOS_DATA* table.

**Note!**

Do not drop the data tables manually; instead delete the entry from the *S_QOS_DATA* table, and the tables will be dropped by a trigger. You must restart the *data_engine* afterwards.
SLA configuration tables

The Service Level Manager is used to describe the SLAs and the descriptions are stored in the following key tables:

- `S_SLA_DEFINITION`
- `S_SLO_DEFINITION`
- `S_QOS_CONSTRAINTS`

There are also other tables, containing data about exclude periods, operating periods, and so on. Here is a list of some of these tables.

- `S_SLA_EXCLUDE_PERIOD, S_SLO_EXCLUDE_PERIODS`
- `S_SLA_NOTES, S_SLO_NOTES`
- `S_SLA_CALCULATION, S_SLO_CALCULATION, S_QOS_CALCULATION`
- `S_OPERATING_PERIOD, S_TIME_SPECIFICATION`

SLA calculation tables

The first step for a SLA to be calculated is that a job is added to the `D_SLA_JOBS` table manually by a user or automatically by the `sla_engine`. The `sla_engine` detects that there is a new calculation job and performs the calculations. The results are stored in these tables:

- `D_SLA_COMPLIANCE`
- `D_SLO_COMPLIANCE`
- `D_QOS_COMPLIANCE`

When the last job for a SLA in the compliance period is calculated, the result will be added to the historic tables:

- `H_SLA_COMPLIANCE`
- `H_SLO_COMPLIANCE`
- `H_QOS_COMPLIANCE`
Account tables

The following tables were added to the database in Nimsoft Release 3.30 to support the Account views and data ownership functionality.

- Accounts Table (CM_ACCOUNT)
- Contacts Table (CM_CONTACT)
- Account-SLA reference Table (CM_ACCOUNT_SLA)
- Account Web Profile Table (CM_ACCOUNT_WEB_PROFILES)
- Origins Table (CM_ACCOUNT_OWNERSHIP)
- Roles Table (CM_ROLE)

SLA Engine

Overview

The primary task of the SLA Engine is to compute Service Level Agreement compliance for the SLAs, based on the settings for the different SLAs done in the Service Level Manager.

Calculation jobs are automatically started and run on a schedule specified in the sla_engine user interface.

For more details, please refer to SLM Probes → sla_engine → sla_engine Configuration section in the Probes online help.

However, calculation jobs may also be started manually (see Exporting QoS Data Series)

Data Engine

The Data Engine has two primary focus areas:

- Subscribes to Quality of Service messages.
- Inserts QoS data into the database.
The *Data Engine* should ideally be installed as close to the database server as possible, preferably on the same server to reduce the network traffic. A subscriber channel is opened to the primary *Hub*, and this hub will be referred to as the SLM Hub. QoS messages are fed to the *Data Engine* using this channel. The incoming messages will be reacted upon, and database operations will be performed accordingly.

**Quality of Service Messages**

Please note that the Quality of Service requires a valid license (SLM-QOS) in the *Data Engine*.

For more details, please refer to SLM Probes ➔ data_engine ➔ data_engine Configuration section in the Probes online help.

**Defining the Quality of Service Object**

Any QoS enabled probe will initiate itself (during startup) by sending a *QOS_DEFINITION* message. This is picked up by the *Data Engine* and decoded for information. The content of this message refers to a Quality of Service object in the database. The object will **automatically** be created in the database with the provided information. You may, however, also create the QOS object **manually**, by adding the definition using the Service Level Manager.

This is done by selecting New > Quality of Service in the menu bar.
The following table describes the various fields in the dialog form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The actual object name.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the QoS object.</td>
</tr>
<tr>
<td>Group</td>
<td>The group the object belongs to (drop-down list).</td>
</tr>
<tr>
<td>Unit</td>
<td>A string stating the unit (e.g. Milliseconds, Centimeter, etc.).</td>
</tr>
<tr>
<td>Unit abbreviation</td>
<td>Used by reports and views (e.g. ms, cm, % etc.).</td>
</tr>
<tr>
<td>Has maximum value</td>
<td>Defines the object with a maximum value.</td>
</tr>
<tr>
<td>Is of type Boolean</td>
<td>Sets the type of the object to be Boolean (True/False).</td>
</tr>
</tbody>
</table>
Populating the Quality of Service Tables

The QoS enabled probe will issue a QOS_MESSAGE on each run. This message refers to an object that should be defined in the database and contains sample data (such as time, value, source, target, etc.)

You can display the database usage (which objects that occupies most space) by selecting **Tools/Database status** on the Service Level Manager menu-bar.

The Service Level Manager Application

Service level monitoring is mostly an automated task. When the SLA is defined and activated, data is recorded and computed in the background.

The Service Level Manager enables the administrator to quickly define and deploy SLAs based on objectives present in the agreements between the client and the service-provider. It interfaces the database using ADO, to display and modify the configuration, to display historic data, current data etc.

You will find this application after logging into SDP under **Actions > Service Level Manager**.
Chapter 2: Compliance Calculation

Introduction

The primary task of the Nimsoft SLA Engine is to compute Service Level Agreement compliance for the SLAs, based on the settings for the different SLAs done in the Service Level Manager.

Calculation jobs are automatically started and run on a schedule specified in the sla_engine user interface.

Note: For more details, please refer to SLM Probes → sla_engine → sla_engine Configuration section in the Probes online help.

However, calculation jobs may also be started manually (see Watching SLA Calculations)

Definition of Compliance Percentage

The compliance percentage is defined to be the percentage of time that the QoS, constrained by e.g. operating period and thresholds, should be considered compliant within the compliance period.

Each sample is checked within the compliance period by the data_engine and summarized as failed or successful. The result is compared against the expected compliance percentage (defined by the user).
Consider the data represented by the illustration. The red line represents the threshold value, the green line represents the average value and the blue line represents the actual sample values.

How many samples within the operating period are above the threshold settings?

Zero samples breach the threshold line within the operating periods, thus fulfilling 100% of our compliance requirements. The 5 samples that breach the threshold are outside the compliance period, which was e.g. Monday to Monday, with operating periods, every weekday from 08:00 to 17:00.

Let’s assume that the total number of samples within the operating period is 129, with 9 samples breaching the threshold. This implies that 6.98% of the samples are accounted for as out of compliance (9 * 100/129).

If our Service Level Agreement requires a compliance of 98.50% (or better) and the only data defined in this SLA is the above data, then our requirements to the SLA is breached due to a current compliance percentage of 100% - 6.98% = 93.02%.
Defining the Calculation Terms and Conditions

A SLA consists of one or more SLOs, each with one or more QoS constraints.

- The compliance is calculated on each QoS and forwarded to the SLO.
- The SLO handles the received compliance data from the underlying QoS’s, makes its calculations and forwards the result to the SLA.
- The SLA handles the received compliance data from the underlying SLOs and calculates the total compliance percentage.

**QoS Constraints**
Each of the QoS constraints compares the collected data values from the probes with the defined threshold value and calculates the compliance percentage.

**SLOs**
The SLO collects the compliance values from the QoS constraints and computes the compliance percentage based on a selected calculation method (selects the best value, the worst value, the average value etc.). The result is made available for the SLA.

**SLA**
The SLA collects the compliance value from the two SLOs and calculates the total compliance value, also based on a selected calculation method.
Calculation Terms and Conditions for the QoS

The QoS reflects the data series measured by the probes. The compliance percentage is calculated for each QoS, and the results are presented to the SLO. The compliance percentage for a QoS is calculated, based on the following parameter settings:

- **Threshold value**
  You define a threshold value for each QoS, against which each sample in the data series received from the probe is compared. 972 sample values of 1000 equal to, or better than the specified threshold value, means 97.2 % compliance for that QoS.

- **Operating period**
  Defines in which time period the compliance percentage should be measured (e.g. Monday to Friday from 08:00 – 17:00). Data series outside this period does not influence the compliance percentage.

- **Calculation method**
  Here you can select between different calculation methods, determining the way the compliance percentage is calculated for the QoS:

  - **Default**
    Calculation based on all received samples in the operating period. Missing samples are excluded.

  Or

  A set of configurable custom defined formulas. The following formulas are currently available:

  - Average of all samples
  - Number of samples that meets the constraints
  - The median value of all samples
Calculation Terms and Conditions for the SLO

The SLO receives the compliance calculations from the associated QoS’s. The compliance percentage is calculated on each SLO, and the result is presented to the SLA.

The compliance percentage on the SLO is calculated, based on three different parameters:

- **Excluded period**
  You can specify periods, which will not count when the compliance is calculated for the SLO. This may e.g. be periods when the monitored system is planned to be shut down due to maintenance etc.
  Note that the compliance data received from the QoS’s within this excluded period will not count when the compliance is calculated.

- **Calculation method**
  Here you can select between different calculation methods determining the way the compliance percentage is calculated for the SLO.

- **You may select between two different types of calculation methods, *Formula* or *Profile*:**
  - **Formula**
    Here you can select a mathematical formula to calculate the compliance percentage, based on the input from the QoS’s:
    **Average**
    Calculates the average value of the input from the QoS’s.
    **Best**
    Looks for the QoS with the best result and selects this result.

    **Sequential**
    The difference between 100 % and the achieved compliance for each QoS is summarized and then extracted from 100%.
    Example: The SLO receives the compliance calculations from two QoS’s with compliance of 70% and 90 %.
    Calculated compliance:
    \[ 100 \% - ((100 \% - 70 \%) + (100 \% - 90 \%)) = 60 \% \].
Weight
The possibility to weigh the importance of the different QoS

Worst
Looks for the QoS with the worst result and selects this result.

- Profile
  A set of configurable custom defined formulas, currently available are:
  
  AND. The values of all samples in all QoS's are AND-ed, resulting in one compliance value. AND means that all sample values from all QoS's simultaneously must equal or be better than the threshold value to be compliant. See also the section Definition of Multi-series Calculation.

  OR. The values of all samples in all QoS's are OR-ed, resulting in one compliance value. OR means that at least one of the sample values must equal or be better than the threshold value to be compliant. See also the section Definition of Multi-series Calculation.
Calculation Terms and Conditions for the SLA

The SLA receives the compliance calculations from the associated SLOs and calculates the total compliance percentage, based on three different parameters:

- **Operating period**
  Defines in which time period the compliance percentage should be measured (e.g. Monday to Friday from 08:00 – 17:00). Data series outside this period does not influence the compliance percentage.

- **Weight**
  Possibility to weigh the importance of the different SLOs.

- **Calculation method**
  Here you can select a mathematical formula to calculate the compliance percentage, based on the input from the SLOs:
  - **Average**
    Calculates the average value of the input from the SLOs.
  - **Best**
    Looks for the SLO with the best result and selects this result.
  - **Sequential**
    The difference between 100 % and achieved compliance for each SLO is summarized and extracted from 100%.
    Example: The SLA receives the compliance calculations from two SLOs with compliance of 70% and 80 %.
    Calculated compliance: 100 % - ((100 % -70 %) + (100 % -80 %)): 50 %.
  - **Weight**
    Enables the possibility to weigh the importance of the different SLOs.
  - **Worst**
    Looks for the QoS with the worst result and selects this result.
Service Level Agreement

A Service Level Agreement (SLA) monitors and calculates the compliance from one or more Service Level Objectives(s) (SLO).

The compliance values are calculated according to the selected Calculation method:

- **Average**
  Calculates the average compliance from the SLOs.

- **Best**
  Selects the SLO with the best compliance value.

- **Sequenced**
  The difference between 100% compliance and actual achieved compliance for each SLO are summarized. The sum is then extracted from a compliance of 100%.

- **Weight**
  Calculates the compliance according to the weighted value applied for each SLO.

- **Worst**
  Selects the SLO with the worst compliance value.

SLOs monitor the computed values from one or more QoS constraints.

The values from the QoS constraints are calculated according to the selected Calculation method:

- **Average**
  Calculates the average compliance from the QoSs.

- **Best**
  Selects the QoS with the best compliance value.

- **Sequenced**
  The difference between 100% compliance and actual achieved compliance for each QoS are summarized. The sum is then extracted from a compliance of 100%.

- **Weight**
  Calculates the compliance according to the weighted value applied for each QoS.

- **Worst**
  Selects the QoS with the worst compliance value.

User defined Calculation Profiles:

- **And**
  Calculates the compliance value for the different QoS measurements within the same time period. The AND operator makes sure that all the QoS constraints are valid only when the samples are within the threshold at the same time period.

- **Or**
  Calculates the compliance value for the different QoS measurements within a time period. The OR operator makes sure that all the QoS constraints are valid when one or more of the QoS constraints are within the threshold in the given time period.

One or more QoS Constraints are attached to a SLO.

A QoS Constraint is a QoS sample value, following a set of calculation rules:

- **Default**
  Calculates the percentage achieved according to the valid number of samples within the time period.

User defined Calculation Profiles:

- **Average of all samples**
  Calculates the average value for all the samples. Parameters that can be modified are:
  - `Availability` in percentage on breach
  - Values used to replace NULL values

- **Availability when samples are missing**
  Adjust parameter on how missing samples should be calculated.

- **Median**
  Calculates the availability from the median of the QoS samples. Parameters that can be applied are:
  - Ignore values at the top
  - Ignore values below
Definition of Multi-series Calculation

When defining the calculation settings for a SLO, you have the option to select a multi-series calculation profile.

(These profiles are custom-defined - see the section Creating a Calculation Profile).

Currently supported profiles are:

- **OR**
  Compliant if one of the QoS constraints equals or are better than the threshold value.

- **AND**
  Compliant when all of the QoS constraints equals or are better than the threshold value.
Example OR:

**OR** - At least one of the data series must equal to or be better (in this example lower) than the expected value:

In the graph above, this is achieved, except for the period marked red.

Example AND:

**AND** – Both data series must be equal to or better (in this example lower) than the expected value:

In the graph above, this is achieved, except for the period marked red.
Calculation Examples

QoS Constraints
Each of the QoS constraints compares the collected data values from the probes with the defined threshold value and calculates the compliance percentage.

SLOs
The SLO collects the compliance values from the QoS constraints and computes the compliance percentage based on a selected calculation method (selects the best value, the worst value, the average value etc.). The result is made available for the SLA.

SLA
The SLA collects the compliance value from the two SLOs and calculates the total compliance value, also based on a selected calculation method.

Example 1, one QoS and one SLO

If using calculation method other than Default for the QoS, see the section Creating a Calculation Profile.

Data series for QoS 1 | Threshold value: 4
4 6 7 6 6 7 4 3 8 7
9 of 10 samples equal to or better than the threshold value gives a compliance value of 90%.

QoS 1
Calculation method: Default.
Computed value = 90%

SLO 1
Calculation method: Doesn’t matter.
Computed value = QoS 1 = 90%

Service Level Agreement
Calculation method: Doesn’t matter (just one SLO).
Computed value = SLO 1 = 90%
Example 2, two QoS’s and one SLO

If using calculation method other than Default for the QoS, see the section Creating a Calculation Profile.

Data series for QoS 1: Threshold value 4
1 8 7 9 5 7 4 3 1 7
9 of 10 samples equal to or better than the threshold value gives a compliance value of 90%.

QoS 1
Calculation method: Default
Computed value = 90%

Data series for QoS 2: Threshold value 5
5 5 4 7 1 3 7 1 3 8 7
5 of 10 samples equal to or better than the threshold value gives a compliance value of 50%.

QoS 2
Calculation method: Default
Computed value = 50%

SLO 1
Calculation method: Best
Computed value = Best of QoS 1 and QoS 2 = 90%

Service Level Agreement
Calculation method: Doesn’t matter (just one SLO).
Computed value = SLO 1 = 90%
Example 3, two QoS’s and one SLO, using Calculation method AND or OR

If using calculation method other than Default for the QoS, see the section Creating a Calculation Profile.

Example 4, two SLOs, each with 3 QoS

If using calculation method other than Default for the QoS, see the section Creating a Calculation Profile.

The figure at the bottom of this page shows a SLA with two SLOs, each with three QoS constraints.

Example assumptions:

On the figure below:

- **SLO 1**: Calculating the compliance percentage from QoS 1, 2 and 3, using calculation method Worst makes a compliance percentage of 70%.
- **SLO 2**: Calculating the compliance percentage from QoS 4, 5 and 6, using calculation method Average makes a compliance percentage of 90%.
The table below the figure shows the total SLA compliance percentage, using different calculation methods for the SLA.

- **QoS 1**
  - Computed value: 100%
  - Calculation method: Default

- **QoS 2**
  - Computed value: 100%
  - Calculation method: Default

- **QoS 3**
  - Computed value: 70%
  - Calculation method: Default

- **QoS 4**
  - Computed value: 100%
  - Calculation method: Default

- **QoS 5**
  - Computed value: 90%
  - Calculation method: Default

- **QoS 6**
  - Computed value: 80%
  - Calculation method: Default

- **SLO 1**
  - Calculation method: Worst
  - Selects the compliance from the QoS Constraints with the worst values.
  - Achieved Compliance (worst of QoS1, QoS2 and QoS3): 70%)

- **SLO 2**
  - Calculation method: Average
  - Calculates the average compliance from the QoS Constraints.
  - Achieved Compliance: Average of (100% + 90% + 80%)/3=90%

**Service Level Agreement**
- Calculation method: Best
- Selects the compliance from the SLO with the best values.
- Achieved compliance (best of SLO1 and SLO2): 90%
The table shows the SLA compliance percentage for the example above, selecting different calculation methods for the SLA:

<table>
<thead>
<tr>
<th>Calculation method</th>
<th>Achieved compliance</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>80 %</td>
<td>The average value of the two SLOs (70% + 90%)/2: 80 %</td>
</tr>
<tr>
<td>Best</td>
<td>90 %</td>
<td>The best value of the two SLOs (70% and 90%): 90 %</td>
</tr>
<tr>
<td>Worst</td>
<td>70 %</td>
<td>The worst value of the two SLOs (70% and 90%): 70 %</td>
</tr>
</tbody>
</table>
| Sequential         | 60 %                | The difference between 100 % and achieved compliance for each SLO is summarized and extracted from 100%:  
|                    |                     | 100 % - ((100 % - 70 %) + (100 % - 90 %)) = 60 %. |
| Weight             | 82 %                | Assuming that the weight distribution between SLO 1 and SLO 2 is set to 40 / 60 for the SLA:  
|                    |                     | (70 % * 40/100) + (90 % * 60/100) = 82 %. |
Chapter 3: Service Level Manager Reference Guide

The Service Level Management application window consists of the following main parts:

- The Menu Bar
- The Navigation Pane
- The Main Window Pane
The Menu Bar

This section gives a short description of the different functions and tools found in the menu line. Note that some of the menus are partly restricted, depending if your user is classified as operator or super user.

New

This option can be used when defining a new:

- **Service Level Agreement**
  Opens the Service Level Agreement dialog, here you can create new SLAs. See description in the section *Creating Service Level Agreement*.

- **Operating Period**
  Opens the Operating Period dialog; see description in the section *Creating an Operating Period*.

- **Quality of Service**
  Opens the QoS Definition dialog; see description in the section *Defining a Quality of Service object*. 
Tools

This option can be used when defining a new:

- **SLA Calculations**
  Opens the Service Level Calculations window, listing the last calculations for currently running SLAs. Double-clicking the entries in the list, you can observe the calculated SLA Compliance for each of the SLAs in separate windows.

- **Database Status**
  Opens the Database Status window. The window contains relevant database information, such as:
  - Database information, such as server name and database name, size and location.
  - Listing QoS objects and probes enabled for sending QoS messages to the database.
  - See description in the section Viewing the Actual Database Usage.
○ **Data Management**
  Opens the Data Management dialog. The data_engine may be configured to perform automatic clean-up procedures, but using the Data Management dialog, you may perform manual data-management.

○ **QoS Monitors**
  Selecting this option, the QoS Monitors window will be launched, listing the QoS Monitors defined (if any).

  QoS Monitors can be defined by clicking icon beside a QoS object in the Navigation pane, selecting Create Monitor.

  This feature introduced in SLM version 4.30 will be activated and visible, if the qos_engine probe is installed.

○ **Wizards**
  Lets you start a wizard for creating a one or more SLAs, based on your selections through the wizard. A group will be created with one or more SLAs in the group. There are three different types of wizards:

  Creating SLAs from scratch, based on a selected service, see
Example – Creating a SLA based on a service.

Creating SLAs based on an existing SLA. Selecting a SLA in the Navigation Pane, the wizard will create a new SLA, based on the properties for the selected SLA.

Exporting QoS data. For more details, see Exporting QoS data, using Export QoS Data wizard.

Adding an Excluded period. Normally this is done individually for SLAs/SLOs in the respective dialogs. Using this wizard, you can add an Excluded period and attach the period to some or all of your existing SLAs/SLOs.

- **SQL Query**
  Opens the SQL query dialog, enabling you to send SQL queries to the database. This is useful if you want to test and view the database contents. Also, see the section **Sending SQL Queries** to the database.

**Save**

Let us you save new definitions (as described under **New** (above), or any modifications in existing definitions.
Window

<table>
<thead>
<tr>
<th>WINDOW</th>
<th>HELP</th>
<th>OPEN WINDOWS</th>
<th>HELP</th>
<th>SERVICE LEVEL AGREEMENT [URL RESPONSE SLA]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Open Windows</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maximized</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Preferences</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In addition to the menu options described below, you have the following possibilities to handle child-windows opened in the Main Window Pane:

**Open Windows**

Shows the list of currently open windows. At any given time, you can open any number of windows.

**Maximized**

If this option is selected, by default it opens the window in maximized state.

**Preferences**

The following options and properties are available:

- **Edit QoS Constraint on double-click**
  - When this option is checked, double-clicking a QoS constraint in a
SLO dialog opens the properties dialog for the QoS constraint. When this option is NOT checked, double-clicking a QoS constraint in a SLO dialog opens the QoS constraint graph.

Note that pressing the Shift key when double-clicking a QoS constraint in a SLO dialog will toggle this functionality.

- **QoS Data Folders**
  This option lets you organize the QoS objects located under the QoS node in the Navigation Pane into folders.

  **Folder is created on:**
  Lets you define the minimum number of objects that must be present to enable for automatically organizing the objects into folders.

  If set to e.g. 5, the Disk Usage group of objects shown below will not be grouped, (only 4 objects present in the group)

**Help**

Provides Version info and shortcuts to online documentation.
The Navigation Pane

The Navigation Pane is present to the left-hand side of the application. It can be collapsed by clicking the icon and can be opened again by clicking the icon. It contains a tree-like structure, showing the various elements/nodes in the Nimsoft Service Level Management product suite.
Service Level Agreements

This node lists all defined SLAs. Click icon to see the list of already existing SLA’s. The SLAs may appear as:

- **Single SLAs**

- **Grouped SLAs**
  The SLAs may be placed in one group, or in sub-groups on multiple levels under the main group. SLAs can be moved between groups, using drag-and-drop.

- **SLAs attached to Accounts**
  Under the Accounts node, you will find all Accounts available. When creating SLAs, these can be attached to one of these Accounts. Under these Accounts, you may again create groups where you place the SLAs.

  SLAs can be moved between groups, using drag-and-drop.

  Click icon to define new SLAs or SLA groups,

  - **New SLA**
    Opens an empty SLA dialog, where can define a new SLA (see the section
Creating Service Level Agreement).

- **New Group**
  Opens a New Group dialog, where you can define a new SLA group. Give the new group a name and optionally a description.

- **Refresh**
  Updates the Service Level Manager to reflect the latest modifications.

A SLA group or an Account is selected:

- **View**
  Opens the current group in edit mode. You can view or edit the desired group details and save it.

- **New Group**
  Opens a New Group dialog, where you can define a new SLA group. Give the new group a name and optionally a description.

- **New SLA**
  Opens an empty SLA dialog, where you can define a new SLA.
Creating Service Level Agreement).

- Delete
  Deletes the selected SLA group, including all SLAs in that group.

![Delete SLA Group dialog box]

Do you wish to remove the SLA group 'New Group', with its siblings?
Please note this operation is irreversible...

[Yes  No]
- **Recalculate**
  Starts a new calculation job for all SLAs in the selected group.

  **Note:** Clicking Recalculate option of a SLA group will not open the Job Properties dialogue. To see the Job Properties dialogue, select the Recalculate option of individual SLA within the group.

- **Refresh**
  Updates the Service Level Manager to reflect the latest modifications.

A SLA is selected:

- **View**
  Opens the current SLA in edit mode. You can view or edit the desired SLA details and save it.

- **New**
  Opens an empty SLA dialog, where you can define a new SLA (see the section
Creating Service Level Agreement).

- **New Clone**
  Makes a copy of the selected SLA.

- **New Based on**
  Starts the SLA wizard, enabling you to create a new SLA, based on the selected one. Note that you are not allowed to edit all parameter input fields (some of them are locked).

- **Delete**
  Deletes the selected SLA.

- **Recalculate**
  Starts a new calculation job for the selected SLA. The Job Properties dialog is opened, allowing you to edit the job parameters.

- **Refresh**
  Updates the Service Level Manager to reflect the latest modifications.
**Operating Periods**

This node lists the defined operating periods. Operating Periods are used to constrain the measured QoS values to specific hours of any day (the period the QoS constraint is valid.)

The operating period is defined to be a collection of time periods, and is used when we define new SLAs. We use the Operating Periods while defining the QoS constraints (see the section *Creating an Operating Period*).

This means that samples falling outside these time specifications will not influence the SLO/SLA compliance requirements.

Click icon and select *New Operating Period* which opens an empty dialog, enabling you to define a new Operating Period (see the section *Create an Operating Period*).

Click icon that is beside one of the defined Operating Periods listed under the node, which opens a small menu containing four options:

- **View**
  
  *Opens the existing Operating Period in edit mode. You can view or edit the existing Operating Period and save it.*
- **New**
  
  Opens an empty dialog, enabling you to define a new Operating Period.

- **Refresh**
  
  Updates the Service Level Manager to reflect the latest modifications.

- **Delete**
  
  Deletes the selected Operating Period.
Calculation Profiles

This option allows users to define their own calculation profiles.

These calculation profiles are used when defining the calculation properties for Service Level Objects and Quality of Service Constraints.

When defining calculation profiles, the profiles will be grouped either as SLO calculations or as QoS calculations, depending on if the selected plug-in supports single-data or multi-data series. See the section *Creating a Calculation Profile and Compliance Calculation*.

- Click the icon beside the SLO Calculation sub-node (or one of the defined SLO calculation profiles), selecting New, opens an empty dialog enabling you to define a new SLO Calculation profile.
- Click the icon beside the QoS Calculation sub-node (or one of the defined QoS calculation profiles), selecting New, opens an empty dialog enabling you to define a new QoS Calculation profile.

Clicking icon offers four other options, common for both sub-nodes.

- **View**
  
  Opens the existing Operating Period in edit mode. You can view or edit the existing Operating Period and save it.

- **New**
  
  Opens an empty dialog, enabling you to define a new Operating Period.

- **Refresh**
  
  Updates the Service Level Manager to reflect the latest modifications.

- **Delete**
  
  Deletes the selected Operating Period.
Quality of Service

Under this node, you will find the available registered QoS objects, grouped into logical groups based on the description field in the QoS object. This view enables the user to quickly browse the database for particular data-series.

Click icon beside QoS node that opens a small menu containing four options:

- **Browse Menu Editor**
  Launches the Browse Menu Editor, enabling you to define your own ways to group and sort the QoS objects listed under the QoS Node.

Clicking the Add button, a new sorting view will be added to the list. The new entry will by default be given the name New Menu Item. Rename it, giving it a descriptive name.

Select your sorting criteria, one or more, from the Data Selector drop-down menus and select descending or ascending sorting order.
Click the OK button, and you will be asked if you want to save the view.

Clicking the Delete button, the selected view will be deleted.

When saved, the entries in the list will appear as menu items in the menu available when you click icon beside the QoS node in the Navigation Pane.

They will be presented in the order they appear in the list in the Browse Menu Editor.

Use the positioning buttons to move items up and down until the entries are listed in your preferred order.

When saved, the new views will appear as menu items when you click icon beside the QoS node in the Navigation Pane

- **Order by QoS group**
  All QoS objects will be presented in their logical groups. In addition, see the section Properties for information on sorting and organizing QoS objects in folders.

- **Order by QoS**
  All QoS objects will be listed alphabetically (and not grouped). In addition, see the section Properties for information on sorting and organizing QoS objects in folders.

- **Order by Probes**
  All the QoS objects will be listed as per the Probes.
Main Window Pane

This is the application frame. All child-windows will be contained within the frame of the main-window, thus following the minimize/maximize schemes.
Chapter 4: Service Level Manager User Guide

The Service Level Manager application is your tool to create and modify Service Level Agreements (SLAs) and to view and print graphs.

The main components involved in Service Level Management are:

- **Probes** that must be prepared to deliver Quality of Service Data (see the section *Setting up a Probe to Deliver Quality of Service Data*).

- The SLM **database**, the *Nimsoft Data Engine* and the *Nimsoft SLA Engine* all installed during the SLM installation.

- The **SLM application**, with which we can perform a lot of management tasks, such as:
  - Define SLAs (see *Example - Defining Simple Service Agreement or Creating Service Level Agreement*)

Service level monitoring is mostly an automated task. When the SLA and the underlying structure is defined and activated, data is recorded and computed in the background.
Login

You can open the SLM application through Service Delivery Portal. Install SDP on your machine and login by giving appropriate Username and Password.

Once you have logged into SDP, under Actions menu select Service Level Manager option as shown in figure below. This will open the SLM Application in separate browser.
Creating Service Level Agreements

The process of creating Service Level Agreements consists of the following steps:

Create a new SLA and define your
- Compliance requirement.
- Compliance period.
- Calculation method.
- Excluded periods.
- Optionally attach the SLA to an account.

Create your SLO(s) and define your
- Calculation method.
- Excluded periods.

Defining QoS constraints with
- QoS Object and source.
- Defined expected QoS value.
- Operating period.
- Calculation method.

Creating a SLA

There are several ways to invoke the Service Level Agreement dialog:

If you first want to create a new group for the SLA, you click icon in the Service Level Agreement Node in the Navigation Pane and select New Group.

If you want to place the SLA in a specific SLA group, you click icon beside that group in the Navigation Pane and select New SLA.

Create a new SLA by:

- Selecting New > Service Level Agreement.
- Click the icon beside Service Level Agreement option in the
Navigation Pane and select *New SLA*.

**Introduction**

Enter a descriptive name and a complete description of the SLA.

Then add your requirements to the SLA according to your needs and specification:

- General Settings.
- Service Level Objectives.
- Notes for the SLA.
- Recalculating your SLA compliance.
- Excluding data for specific periods.

<table>
<thead>
<tr>
<th>General Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Account</strong></td>
</tr>
<tr>
<td><strong>ID</strong></td>
</tr>
<tr>
<td><strong>Description</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Service Level Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calculation Methods</strong></td>
</tr>
<tr>
<td><strong>Compliance Period</strong></td>
</tr>
<tr>
<td><strong>Status</strong></td>
</tr>
<tr>
<td><strong>Time used in compliance period</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Objectives (SLO)</strong></td>
</tr>
<tr>
<td><strong>Alarm Notification</strong></td>
</tr>
<tr>
<td><strong>Calculations</strong></td>
</tr>
<tr>
<td><strong>Excluded Periods</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Weight(%)</strong></td>
</tr>
<tr>
<td><strong>Fulfilled(%)</strong></td>
</tr>
</tbody>
</table>

**General Settings**

The following table describes the various fields in the SLA form:

**Name**

Provide a short name of the SLA.

**Account**

If you want the SLA to belong to an account, you simply select the account you want the SLA to
belong to from the drop-down list.

An account typically defines a customer/company and the associated privileges. The administrator can create and manage accounts through the Security menu in the Infrastructure Manager Menu bar. See the on-line documentation for the Infrastructure Manager for further information.

**Description**
A longer descriptive text, stating the e.g. purpose of the SLA.

**ID**
Each created SLA is automatically assigned an ID number.

**Percentage**
It sets the compliance percentage of the current SLA.

**Compliance period**

![Compliance Period dialog](image)

Clicking *Compliance Period* button opens the Compliance Period dialog, enabling you to set the SLA compliance period (the period where the compliance percentage is computed), and start date.
The compliance period will constrain the SLA (with its underlying SLO and QoS constraints) to a user-defined timeframe, complying with an agreement between two parties. A typical period for SLA monitoring is on a monthly basis. You may, however, create daily and weekly periods as you wish.

The compliance period will, depending on its type (weekly and monthly) have fixed starting dates. If weekly is selected then the starting day is Monday, and if monthly is selected then the starting day is the first day of the month. However, it is possible to modify the starting day according to your specific needs. E.g. let’s say you want starting day from the 15th; then you adjust the starting date accordingly.

The difference in the interpretation of the starting date for the compliance period types is listed below:

- **Daily**
  The starting date is irrelevant.

- **Weekly**
  The starting date defines the starting day in every week.

- **Monthly**
  The starting date defines starting day of every month.

**Example:**
1 month, starting April 01, 2006, means that the compliance is measured and recorded into the database as soon as the next period starts.

- **Timezone Setting**
  This option enables you to set the time zone for your location. By default, the time zone of the location where the data engine is located is selected. As long as the SLM and the data engine are located in the same time zone,
this setting should normally be used.

If you collect data from another time zone, you can select this time zone here.

**Calculation method**

The SLA Monitors the compliance from the SLO(s). Calculation method is the way the SLA calculates the compliance input from the SLOs (see the section *Compliance Calculation*). It is possible to define excluded periods, where the measured compliance will not influence the SLA (e.g. planned maintenance, company holiday etc.) The sample values are calculated according to the selected Calculation method:

- **Average**
  Calculates the average compliance from the SLOs.

- **Best**
  Selects the compliance from the SLO, if more than one, with the best values.

- **Sequential**
  Summarizes the periods when the expected value is not met for all SLOs and calculates the compliance. The difference between 100 % and achieved compliance for each SLO is summarized and extracted from 100%.
### Weight
Weights the compliance from the different SLOs, according to importance (either auto- or manually defined).

Selecting this option opens the Weight Properties dialog, where you can weigh the importance of the different SLOs, either manually or automatically (see the section Distributing Importance (weight)).

### Worst
Selects the compliance from the SLO with the worst values.

#### Status

The status field gives you the following information:

- **The current period**
  Shows the current period defined by the compliance period settings (see above).

- **Time used in the compliance period**
  Shows the current placement in the compliance period. The dark part indicates how much time is spent of the period.

- **Achieved compliance**
  Shows the current compliance percentage values.

- **Expected compliance**
  Shows the expected compliance percentage values.
• **Trend analysis**  
Indicates if and when the SLA breaches the defined compliance percentage.  
If a part of the bar is red, it indicates how much is used of the “allowed” unavailability. A bar that is almost completely red indicates that it is close to a breach.

**Objectives (SLO)**

The service level objective list shows the status of the objectives within the current SLA. The table below describes the fields and the action buttons related to SLOs.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Weight (%)</th>
<th>Fulfilled (%)</th>
<th>New [Button]</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Responsiveness SLO</td>
<td>URL Responsiveness SLO</td>
<td>Auto</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Name**  
*The short name of the SLO(s). While creating a new SLO application asks you whether you save the SLA first. Save the SLA and then create new SLO.*

- **Description**  
A longer descriptive text, describing the purpose of the objective

- **Weight**  
Shows the settings for the importance of the objective (see *Distributing Importance (weight)*) in relation to the other objectives within the current SLA. The possible values are auto or a percentage value.

- **Fulfilled**  
Shows the level of fulfillment (percent) of the objective. 100% means completely fulfilled.

- **New [Button]**  
Create a new objective within the current SLA.
- **Edit [Button]**
  Edit the selected objective.

- **Delete [Button]**
  Removes the selected objective from the current SLA.

**Legend**

- The SLO is **compliant** with the requirements stated by the SLA and the QoS constraints defined within the SLO.

- The SLO is **not** compliant.

- No compliance values are currently available.
Alarm Notification

SLM is capable of generating alerts whenever a SLA has breached the defined compliance settings. The alert is treated as any alarm, and may be forwarded to e.g. email, paging etc.

- **Alarm when compliance is breached**
  
  Check this option if you want to be notified upon SLA breach. A standard Alarm is issued when the compliance breaches the value you specify in the Expected field (see below).

- **Severity Level**
  
  Select the appropriate severity level.

- **Expected %**
  
  Specify the threshold value for the alarm.

- **Issue warning message at**
  
  Check this if you want to be notified prior to the SLA breach, and also the threshold for generating the warning.
Notes

Any system administrator will comply with the fact that "unscheduled things may happen". E.g. you may want to notify about an event that occurred in the operating period and therefore affected the outcome of the SLA compliance.

- **Date**
  Ties the note to a specific date/time.

- **Title**
  A descriptive text, describing the reason for the note.

- **Official**
  Defines the note to be official

- **Text**
  The actual text body of the note

- **New [Button]**
  Create a note within the current SLA. The Note editor appears, enabling you to type your note.
Edit [Button]
Edit the selected note.

Delete [Button]
Removes the selected note from the current SLA.

Calculations

A compliance calculation is automatically performed on schedules as specified in the sla_engine. You may, however, require a recalculation due to various reasons by creating a new calculation.

The list shows all available compliance jobs related to the current SLA.

- **Job Id.**
  The job identification number assigned to a new job.

- **Period Begin**
  Defines the starting date/time of the compliance calculation period.

- **Period End**
  Defines the end date/time of the compliance calculation period.

- **Owner**
  The name of the operator that requested the calculation job

- **Job Start**
  Defines the date/time for when the compliance calculation job should start.

- **Job Expire**
  Defines the date/time for when the job is automatically removed from the SLM system.

- **History**
  Indicates that compliance data should recorded/saved for historic reports.

- **New [Button]**
  Initiates a new compliance calculation using the current SLA.
Edit [Button]
Edit the selected job (only available when the job is queued).

Delete [Button]
Deletes the job from the system.

View [Button]
View the result of the compliance calculation.

Also see the section *Exporting QoS Data Series*.

**Excluded Periods**

In normal system management scenarios, services are subject to maintenance. Some maintenance is scheduled and some is not. Depending on the service level agreement between the parties involved, data may (or may not) be excluded due to unavailability of the service. The unavailability will most certainly affect the SLA compliance.

- **From Date**
  Defines the starting date/time for when to exclude data.
- **To Date**
  Defines the starting date/time for when to exclude data.

- **Note**
  The textual note (title and a description) related to this exclude period.

- **Official**
  Should the exclude period appear on the reports.

- **New [Button]**
  Opens the Exclude period dialog, enabling you to define an exclude period for the current SLA.

- **Edit [Button]**
  Edit the exclude period and note.

- **Delete [Button]**
  Deletes the exclude period from the current SLA.

When clicking the OK button, the excluded period newly created will appear in the list.

See also the section *Excluding Quality of Service Data.*
Creating a Service Level Objective (SLO)

Pressing the New button creates a new SLO form for you to complete. Enter a descriptive name and a complete description of the objective.

A SLO is built around one or more constrained Quality of Service (QoS) objects. The constraint is a combination of source, target, threshold and operating period settings for the QoS object.

You may invalidate the objective for certain periods, either known scheduled "down-time" due to maintenance etc. or unforeseen situations.

Breaches of the objective may also be reported as alarms, as you could with SLAs.

These are the various fields in the main SLO form:

- **Name**
  The short name of the SLO.

- **Description**
  A longer descriptive text, stating the e.g. purpose of the SLO.

- **Status**
  Shows the compliance percentage of the current SLO.

- **Expected (status)**
  Shows the expected compliance percentage.
The Quality of Service Tab

- **QoS Name**
  The official name of the Quality of Service object.

- **QoS Description**
  The description of the Quality of Service object

- **Source**
  States the source of the QoS data. E.g. computer, device etc

- **Target**
  States the target of the QoS data. E.g. the disk, network service, CPU, etc

- **Weight**
  Shows the importance of the QoS constraint in relation to the other QoS objects within the current SLO. The possible values are auto or a percentage value.

- **Fulfilled**
  Shows the level of fulfillment (percent) of the QoS constraint. 100% means completely fulfilled.

- **Operator**
  The operator code for the value comparison

- **Threshold**
  The value set as expected QoS value for the QoS constraint.

- **Operating period**
  The defined operating period for the QoS constraint

- **Total**
  The number of sampled data used in the calculations.

- **Accuracy**
  The accuracy of the sampled data

- **Calculation Method**
  The selected calculation method for the QoS constraint

- **Order**
  The order of the QoS constraint in the list.
- **New [Button]**
  Create a new QoS constraint within the current SLO.

- **Edit [Button]**
  Edit the selected QoS constraint.

- **Delete [Button]**
  Removes the selected QoS constraint from the current SLO.

- **Browse [Button]**
  Browses the QoS samples related to the current compliance period.

The Quality of Service constraints for the current SLO shows a current state based on the last computations by the *SLA Engine*. A **green** indicator illustrates a positive direction, i.e. the QoS is above the SLA compliance percentage. A **red** indicator means that the QoS is not conformant with the expected SLA fulfillment, this may however, not mean that the objective is breached. This depends on the weight of the QoS constraint in relation to the other constraints. The legend is as follows:

- **-** The QoS is compliant within the defined constraints (source, target, threshold and period).

- **-** The QoS is **not** compliant.

- **-** No compliance values are currently available.
**Alarm Notification**

SLM is capable of generating alerts whenever a SLA has breached the defined compliance settings. The alert is treated as any alarm, and may be forwarded to e.g. email, paging etc.

<table>
<thead>
<tr>
<th>Quality of Service</th>
<th>Alarm Notification</th>
<th>Notes</th>
<th>Excluded Periods</th>
<th>Calculations Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Alarm when compliance is breached</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Severity Level</td>
<td>Alarm Message</td>
<td>Threshold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>critical</td>
<td></td>
<td>100</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alarm when warning threshold is breached</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Severity Level</td>
<td>Alarm Message</td>
<td>Threshold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>critical</td>
<td></td>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

**Alarm when compliance is breached**

Check this option if you want to be notified upon SLA breach. A standard Alarm is issued when the compliance breaches the value you specify in the Expected field (see below).

**Alarm Message**

Enter the Alarm Message to be generated when compliance is breached.

**Threshold**

Specify the threshold value for the alarm.

**Alarm when warning threshold is breached**

Check this option if you want to be notified prior to the SLA breach, and also the threshold for generating the warning.

**Alarm Message**

Enter the Alarm Message to be generated when warning threshold is breached.

**Threshold**

Specify the threshold value for the alarm.
Notes

Any system administrator will comply with the fact that "unscheduled things may happen". E.g. you may want to notify about an event that occurred in the operating period and therefore affected the outcome of the SLA compliance.

- **Date**
  Ties the note to a specific date/time.

- **Title**
  A descriptive text, describing the reason for the note.

- **Official**
  Defines the note to be official

- **Text**
  The actual text body of the note

- **New [Button]**
  Create a note within the current SLO. The Note editor appears, enabling you to type your note.
Edit [Button]
Edit the selected note.

Delete [Button]
Removes the selected note from the current SLA.
The Excluded Periods Tab

The service level objective list shows the status of the objectives within the current SLA. The table below describes the fields and the action buttons related to SLOs.

<table>
<thead>
<tr>
<th>From date</th>
<th>To date</th>
<th>Note</th>
<th>Official</th>
<th>New</th>
<th>Edit</th>
<th>Delete</th>
</tr>
</thead>
</table>

- **From date**
  Start of the exclusion period.
- **To date**
  End of the exclusion period
- **Title**
- **Heading of the Note**
- **Note**
  The actual text body of the note
- **Official**
  Defines the note to be official.
- **New [Button]**
  Create a new period within the current SLO.
- **Edit [Button]**
  Edit the selected period.

- **Delete [Button]**
  Removes the selected period from the current SLO.
The Calculation Settings Tab

Here you can select the way the compliance for the SLO is computed (see the section Compliance Calculation).

Calculation methods available depend on the selected Calculation type.

<table>
<thead>
<tr>
<th>Quality of Service</th>
<th>Alarm Notification</th>
<th>Notes</th>
<th>Excluded Periods</th>
<th>Calculations Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculation Type</td>
<td>Calculation Method</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Formula</td>
<td>Average</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>You may configure the way the SLO is computed. Select the method to use when computing the compliance percentage for this SLO. The method you choose is dependent on the selected type.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Calculation Type**

If Formula is selected, you are allowed to select one of the Calculation methods from the drop-down menu.

The calculation methods determine how to use the calculated compliance percentage from the QoS constraints.

The compliance percentage is defined to be the percentage of time that the QoS, constrained by e.g. operating period and thresholds, should be considered compliant within the compliance period.

- **Average**
  Calculates the average compliance percentage from the QoS constraints.

- **Best**
  Selects and uses the compliance percentage from the QoS constraint with the best compliance.

- **Sequential**
  Summarizes the periods when the expected value is not met for all QoS constraints and calculates the compliance. The difference between 100 % and achieved compliance for each QoS is summarized and extracted from 100%.

- **Weight**
  Weights the compliance from the different QoS constraints, according to importance. When
weight is selected, the Weight Properties dialog is opened, enabling you to set the importance of the different QoS constraints.

- **Worst**
  Selects and uses the compliance percentage from the QoS constraint with the worst compliance.

If **Profile** is selected, you are allowed to select one of the defined **Calculation profiles** (if any) from the drop-down list. Note that these are listed under the **Calculation Profiles** node in the **Navigation Pane**. You will then get the **compliance percentage** for the SLO.
Defining a Quality of Service object

Any QoS enabled probe will initiate itself (during startup) by sending a QOS_DEFINITION message. This is picked up by the Data Engine and decoded for information. The content of this message refers to a Quality of Service object in the database. The object will automatically be created in the database with the provided information. You may, however, also create the QOS object manually, by adding the definition using the Service Level Manager. Select File > New > Quality of Service from the menu bar.

The following table describes the various fields in the dialog form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The actual object name on the form QoS_xxx.</td>
</tr>
<tr>
<td>Description</td>
<td>A short descriptive text.</td>
</tr>
<tr>
<td>Group</td>
<td>The group the object belongs to.</td>
</tr>
<tr>
<td>Unit</td>
<td>A string stating the unit (e.g. Milliseconds, Centimeter, etc.)</td>
</tr>
<tr>
<td>Unit abbreviation</td>
<td>Used by reports and views (e.g. ms, cm)</td>
</tr>
<tr>
<td>Has maximum</td>
<td>Defines the object with a maximum value.</td>
</tr>
</tbody>
</table>
value
Is of type Boolean
Sets the type of the object to be Boolean (True/False).

Defining QoS Constraints

The Quality of Service data itself has no value to the service objective unless it is constrained to a specific time-period, specific source/target information and rules to check the actual sample values.

Pressing the New button in the SLO form triggers the QoS constraint dialog-box.

![Quality of Service constraints dialog-box](image-url)
The following table describes the various fields in the dialog-box:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A short descriptive text.</td>
</tr>
<tr>
<td>Object</td>
<td>The Quality of Service object.</td>
</tr>
<tr>
<td>Source</td>
<td>From where the sample-value originates.</td>
</tr>
<tr>
<td>Target</td>
<td>The target name of the sample, e.g. a disk, URL etc.</td>
</tr>
<tr>
<td>Value (Expect Quality of Service to be)</td>
<td>The threshold value, used in conjunction with the rules (greater than, less than etc.</td>
</tr>
<tr>
<td>Unit</td>
<td>A QoS definition describes a unit for the QoS value (e.g. kilo, % mS etc). This will be the default unit. For some QoS objects you can select other units. This drop-down list lets you select another unit, if available. Note that the value will automatically be converted to match the new value. Example: If the value initially is 1 second, and you change the unit to milliseconds, the value will automatically change to 1000.</td>
</tr>
<tr>
<td>In Operating period</td>
<td>For the selected period the constraint is valid. You can select one of the defined operating periods or select Always (means 24 hours a day, 7 days a week).</td>
</tr>
<tr>
<td>Calculation method</td>
<td>Here you can select Default or one of the custom-made Calculation Profiles (if any) for QoS calculations. See the sections Compliance Calculation, and Creating a Calculation Profile. These settings describe the way the SLO will calculate the compliance input from the QoS constraints.</td>
</tr>
</tbody>
</table>
The value dropdown list will (if available) reveal the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Smallest value in sample range (last 24 hours)</td>
</tr>
<tr>
<td>Average</td>
<td>Average value the last 24 hours.</td>
</tr>
<tr>
<td>High</td>
<td>Highest value in the sample range.</td>
</tr>
<tr>
<td>Maximum</td>
<td>The QoS definition states that a maximum value exists for this QoS object, such as a disk sample.</td>
</tr>
</tbody>
</table>

**Viewing the current sample-values**

Use the QoS sample browser (see Viewing Quality of Service Data) to determine the best possible values for your QoS threshold settings.
Distributing Importance (weight)

When setting up service level agreements and objectives, we recognize the fact that some objectives are more important than others. The same fact applies to QoS constraints. The weight distribution feature will help the user to either automatically or manually set up importance (measured in percent) for SLO or QoS constraints.

In Calculations Settings Tab, select Calculation Method as Weight and click Modify Button. Clicking the Modify button opens the weight dialog, showing a pie chart representing the importance (%).
**Automatic Weight Distribution**

Click button for automatic distribution of weight. The weight will automatically be computed based on the number of objects available (objectives or constraints). This is the default method.

**Manual Weight Distribution**

This mode enables the user to manually distribute weight using the selected object (from the list) and the slider. You can also use the + and - buttons for manual weight distribution. Please note that all of the 100% needs to be distributed. The defined weight will then be displayed in the **Weight %** column in QoS tab.

**Creating a Compliance period**

The compliance period will constrain the SLA (with its underlying SLO and QoS constraints) to a user-defined timeframe, complying with an agreement between two parties. A typical period for SLA monitoring is on a monthly basis. You may, however, create daily and weekly periods as you wish.

The compliance period will, depending on its type (weekly and monthly) have fixed starting dates. If weekly is selected then the starting day is Mondays, and if monthly is selected then the starting day is the first day of the month. However, it is possible to modify the starting day according to your specific needs. E.g. let’s say you want starting day from the 15th; then you adjust the starting date accordingly.

Click the Compliance Period button on the SLA dialog to open the Compliance Period dialog.

See below for a description of the difference in the interpretation of the **starting date** (at the bottom of the dialog) for the compliance period types.

**Day**
The starting date is irrelevant.

**Week(s)**
The starting date defines the starting day in every week.

**Month(s)**
The starting date defines starting day of every month.
Timezone Setting

This option enables you to set the time zone for your location. By default, the time zone of the location where the data engine is located is selected. As long as the SLM and the data engine are located in the same time zone, this setting should normally be used.

If you collect data from another time zone, you can select this time zone here.
Creating an Operating Period

Operating periods are used to constrain the measured values (Quality of Service) to specific hours of any day.

The operating period is defined to be a collection of time periods, and is used when we define new SLAs. We use the Operating Periods when defining the QoS constraints.

Samples falling outside these time specifications will not influence the SLO/SLA compliance requirements.

The Operating Period dialog is opened by clicking icon beside the Operating Period Node in the Navigation Pane and selecting the New Operating Period option.

Give the operating period a name and an optional description. Click the New button in the dialog to add days and time specifications.

To edit an entry in the list, simply double-click the entry to open the time specification dialog for the selected entry.
For example, let's create an operating period we can call *Company Hours*. First let's define our work-hours. Normally, they are Monday-Friday, from 0700 to 1700. The scheduled downtime is every Tuesday at 1500-2000 (*).

The "Company Hours" profile will contain a list of time-specifications (days and time) like the one below:

<table>
<thead>
<tr>
<th>Day</th>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday</td>
<td>07:00</td>
<td>17:00</td>
</tr>
<tr>
<td>Tuesday</td>
<td>07:00</td>
<td>15:00*</td>
</tr>
<tr>
<td>Wednesday</td>
<td>07:00</td>
<td>17:00</td>
</tr>
<tr>
<td>Thursday</td>
<td>07:00</td>
<td>17:00</td>
</tr>
<tr>
<td>Friday</td>
<td>07:00</td>
<td>17:00</td>
</tr>
</tbody>
</table>

* We simply ignore the scheduled downtime because it is outside our "work hours".

The format of the operating period and the time-specifications is so flexible that we can create complex operating periods.
Creating a Calculation Profile

Users are allowed to define their own calculation profiles. This is done by clicking the icon beside any of the Calculation Profiles sub-nodes in the Navigation Pane and selecting New.

- Click the icon beside the SLO Calculation sub-node (or one of the defined SLO calculation profiles), selecting New, opens an empty dialog enabling you to define a new SLO Calculation profile.

- Click the icon beside the QoS Calculation sub-node (or one of the defined QoS calculation profiles), selecting New, opens an empty dialog enabling you to define a new QoS Calculation profile.
These Calculation Profiles can be selected when defining the calculation properties for Service Level Objects (SLOs) and Quality of Service Constraints.

The profiles are based on built-in plug-ins distributed with the Service Level Manager application.

- **Name**
  Give the new Calculation profile a name in this field.

- **Description**
  Give a short description of the Calculation profile in this field.

- **Calculation**
  You can select one of the available calculation plug-ins from the drop-down list. Available plug-ins in the list depends on if you have opened the dialog for a SLO calculation profile (multi-series calculations) or the list for a QoS calculation (single-series calculations).
The figure above shows the dialog for the QoS calculation profiles.

We currently have four plug-ins:

**For QoS calculations:**

- *Calculate availability from the average of all samples.*
  
  Finds the average value of all samples and compares this value against the defined threshold value.
  
  - If the average value of all samples meets the constraints, the availability for that QoS is 100%.
  - If the average value of all samples does not meet the constraints, the availability for that QoS is by default set to 0%.

**Note:** Setting the *Breach value* to another value, using *Variable configuration* (see below), and the percentage (on breach) can be set to another value than 0%. Also note that you can define the way NULL values are handled. (NULL value, typically if a probe does not measure a value from the target due to a timeout, e.g. no answer to a ping).

**Example:**

Threshold: 5
Samples: 5,4,8,6,2 and one NULL sample.
Define NULL sample as ignored and Breach Value as 35%, using the *Variables Configuration*.

**Availability:** The NULL sample is ignored, giving an average value of \((5+4+8+6+2)/5 = 4.6\). This is below the threshold (5),
and therefore a breach condition (which we have set to 35%).

- **Calculate availability from number of samples that meets the constraints.**

  This profile calculates the availability by finding the percentage of samples that meets the constraints.

  Note that you may, using the Variables Configuration, define how missing samples should be treated: either ignored (and not influencing the availability) or treated as samples not meeting the constraints.

  **Example:**
  Threshold: 5
  Samples: 5,4,8,6,2 and one sample missing.
  Define missing samples as ignored, using the Variables Configuration).

  **Availability:** One sample missing (ignored), 3 of four samples meets the constraints, giving an availability of 75%.

- **Calculate availability from the median.**

  The median of a number of values is found by sorting the values in a row in descending order. The value found in the middle of the row is the median value.

  **Example:**
  Threshold: 5
  Samples: 5,4,8,6,2.
  Sorted in descending order: 2,4,5,6,8 The value in the middle
of the row is 5, which means that the median value is 5.

**Availability:** The median value 5 means that the threshold value is not breached. This means 100% availability.

Note: Using the Variables Configuration, you are allowed to define a floor level and a ceiling level. Values below the floor level and above the ceiling level will be ignored and not count when calculating the median value.

**For SLO calculations:**

- *Calculate availability by AND-ing or OR-ing the data series.*

- *Calculate availability by logical expression*
  
  For creating a new Multi Expression in SLM, create a new Calculation Profile under SLO Calculations. For setting the logical expression in the profile, set the value of the “Expression” field.

- **Data Series**
  
  - *Automatic*
    
    QoS Data is recorded at intervals as specified in the probe configuration.
  
  - *Asynchronous*
    
    QoS Data is recorded each time the measured value changes.
- **Variable Configuration**
  This field enables you to modify the selected plug-in.

  **Example 1:**
  If using the plug-in “*Calculate availability from the average of all samples*”, you double-click the lines in this field to define how to handle *Null values samples* and *Breach values*.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breach Value</td>
<td>Availability in percentage on breach</td>
<td>Value used to replace NULL samples</td>
</tr>
<tr>
<td>NULL value</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Breach value**
When the average value breaches the defined threshold for the QoS, the average value is by default set to 0% availability for that QoS.
This can be overridden by clicking the *Breach value* entry and set the Breach value to another percentage, e.g. 54% as in this example.

**Null value**
In the case of *Null value* samples in the data series, you have the following options on how these samples should be treated:
- If none of the options described below are selected, a NULL sample
will be treated as a not compliant value.

- **Ignore**
  The samples will be ignored and will not influence on the compliance percentage. The value “0” will be entered in the Value column.

- **Min**
  The samples will be set to the same value as the minimum sample value found in the dataseries. The value “1” will be entered in the Value column.

- **Max**
  The samples will be set to the same value as the maximum sample value found in the dataseries. The value “2” will be entered in the Value column.

![NULL value dialog]

**Note:**
Click the icon beside the NULL value entry and select Clear Parameter to reset the current parameter value.
**Type:**
If using the plug-in with AND or OR calculation, you double-click the line in this field to select if the series should be *AND-ed or OR-ed*.

<table>
<thead>
<tr>
<th>Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Should the series be ANDed or ORed</td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>AND</td>
<td></td>
</tr>
</tbody>
</table>

**Expression**
If using the plug-in with logical expression, you double-click the line in this field to define the logical expression.

<table>
<thead>
<tr>
<th>Expression</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical Expression</td>
<td></td>
</tr>
<tr>
<td>( 1 or 2 ) and ( 3 or 4 )</td>
<td></td>
</tr>
</tbody>
</table>
For setting the expression use following guideline otherwise the expression parser error will occur.

- Use AND, OR and NOT operators either in upper and lower case.

- The QOS are represented by integer number.

- Each expression must be enclosed in bracket.

- Each token in the expression must be separated by a space.

Some valid samples of the logical expression are

- (1 or 2)
- (1 AND 2)
- (1 and (NOT 2))
- (1 AND 2) OR (3 AND (not 4))
Excluding Quality of Service Data

Backup, hardware/software upgrades etc. are normal system administrative tasks that make the systems unavailable for shorter or longer periods of time. Normally these procedures are placed to off-hours, such as evenings and weekends. Scheduled maintenance is covered by the agreement between the service provider and the customer. SLM allows you to exclude data for the period in question prior to the event, or after the event (this requires a recalculation of the SLA compliance).

Excluded periods may be created in two different ways:
You may create an excluded period for a specific SLA by or SLO.
You may create an excluded period for multiple SLAs by running the Add Exclude Period wizard (see the section Creating an Exclude Period using Add Exclude Period Wizard).
Creating an Exclude Period

You may create an excluded period for a specific SLA or SLO by selecting the Excluded Periods tab in the SLA/SLO dialog and clicking the New button. This opens the Exclude Period dialog. Note that Ticking the Add Note option expands the dialog to display the Note section, which otherwise is hidden.

- **From**
  Defines the start date/time for the exclude period.

- **To**
  Defines the end date/time for the exclude period.

- **Add Note**
  Checking this option expands the dialog to display the Note section, which otherwise is hidden.
  The textual note related to this exclude period.

- **Official note**
  If this option is checked, the excluded period and the note will appear on the reports.

- **Title and text**
  A title and a short text, describing the reason for the excluded period.

You may exclude data for the entire SLA or per SLO. The excluded data will not influence the SLA compliance calculations, and should therefore also be present in the report as a note.
Creating an Exclude Period, using the Add Exclude Period Wizard

You may create an exclude period for multiple SLAs by running the Add Exclude Period wizard. Launch this wizard by selecting Tools > Wizards > Add Exclude Period from the menu bar.

This wizard will add an exclude period with an optional note to one or more SLA/SLO definitions.

The first dialog lets you define when the period starts and stops.

Tick the Add Note option lets you add an optional title and description of the period. Ticking the Official Note option, the excluded period and the note will appear on the reports.
Click the *Next* button to continue.

In the next dialog appearing, all SLAs are listed.

If ticking the *Show Service Level Objectives (SLO)* option, also SLOs will be listed below the SLA they are associated with. Select the components to which you want to add the exclude period.

![Add Exclude Period dialog]

Click the *Next* button to continue.

The final dialog appears. Click the Finish button to finish and exit the wizard.

![Add Exclude Period Finish dialog]
Example - Defining a simple Service Level Agreement

**Important prerequisite:**
To be able to measure the service level, you must ensure that the probes monitoring your system are configured to generate QoS (see description in the section *Setting up a Probe to Deliver Quality of Service Data*).

The steps involved when defining a simple SLA are as follows:

1. Define your operating periods.
2. Create a new SLA and define your compliance requirement and measure period.
3. Define the Service Level Objectives that make up your agreement.
5. Excluded periods.
Step 1 – Define an Operating Period

The first step is to define an operating period. You will need it in step 3.

The *Operating Period* dialog is opened by clicking the icon beside the *Operating Period* Node in the Navigation Pane and selecting the *New Operating Period* option.

Defining no period will default to a *24 hours x 7 days per week* service availability, but most organizations have a little more complexity than that. E.g. there may be a regularly scheduled maintenance window when services do not have to be available, or some services may only need to be available during business hours. In the example below, we have chosen to define a “business hours” period.

You can define multiple periods for multiple different services as appropriate.

See also the section *Creating an Operating Period* for more information.

Defined operating periods will appear in the *Operating Periods node* in the Navigation Pane, available when defining new SLAs.
Step 2 – Create a new SLA and Define the Service Level Compliance Requirement

Select New > SLA or click icon beside the SLA Node in the Navigation Pane and selecting the New SLA option.

Give the new SLA a name and a description, and set the compliance percentage to 99.9%.
Click the *Set period* button.

This is the period over which the service level will be measured and your committed compliance amount (measured as a percentage) i.e. if you are going to define a service level of say 99.9% availability; over which period will this be measured? You could define this as a daily service level, in which case your SLA compliance will be measured on a day-to-day basis, or it could be measured weekly or monthly. You also define when you want the measurement period to start.

In this case, we have selected a weekly service level that starts on a Monday and ends on Sunday and we are committed to 99.9% compliance.

Leave the Time zone field empty if your SLM is located in the same time zone as the data engine.

Also, see the section *Compliance Calculation* for selecting a Calculation method different from *Average*, which is default.
Step 3 – Define the Individual Service Level Objectives

Each Service Level Agreement is comprised of one or more Service Level Objectives. Each objective is a data point that we can measure and calculate into the report – the available data points are automatically prompted to the user by using the pull-down tabs.

Make sure the Objectives (SLO) tab is selected and click the New button.

The Service Level Objective window appears. (Note that the section Creating a Service Level Objective (SLO) contains additional information).

![Service Level Objective Window]

Give the new Service Level Objective a name and a description. Select the Quality of Service tab and click the New button.

Now the Quality of Service Constrains dialog appears.

In this case we have selected Network Connectivity Response to be less than or equal to 100 seconds and we have selected that this objective should be measured in the “business hours” period that we defined in step 1. We also have the ability to manually “weight” each objective – so that if there are several objectives for us to meet, we can tell the product either to apply equal weightings (automatically selected) or to weight one objective more heavily than others. In this case, we will just select a single objective. See also the section Manual Weight Distribution for more information.

The definition of the Service Level Agreement is now complete.
Step 5 – Excluding Periods

Now the SLA setup is complete. But what happens if there is an event outside our control that we want to “exclude” from the SLA calculation? Some examples of this could be that you have agreed with your customers that there will be a one-off maintenance window required for applying some much needed Service Packs. Or, maybe there was a complete power outage to your building that you agree should not count towards the SLA calculation or perhaps a company holiday.

We simply enter the period that we wish to exclude, and add a “note” to that exclusion. Again, by selecting the “official note” box, this note will appear on the reports that everyone gets to see. This feature is extremely useful, because it means that we no longer have to go back and manually recalculate data.

In this case, we have agreed with our web-hosting provider that there was critical maintenance to be performed on our SQL Server database to protect it from the latest Internet worm. We have agreed to take a 2-hour outage that will not count towards the SLA Measurement.

For more information, see the section
Creating Service Level Agreement.

Exclude Period

From: July 27, 2010 00:00
To: July 27, 2010 01:00

Add note

Title: SQL Server Maintenance

Official note (on reports)

This period was agreed upon to apply maintenance

Ok Cancel
Creating a SLA, using the SLA Wizard

The SLA Wizard can be launched by selecting the *Tools > Wizards* Option in the Service Level Manager Toolbar.

Two different SLA wizards are available:

- Creating a SLA based on a service
- Creating a SLA based on an existing SLA
Example – Creating a SLA based on a service

This wizard will create a SLA group containing one or more SLAs, based on your selections through this wizard (one SLA for each selected source computer). Each SLA will consist of one SLO with one or more QoS constraints, according to your selections.

- Launch the wizard by selecting Tools > Wizards > Create SLA by Service.

- First you have to select the type of SLA you want to create. You have two options:
  - **Server SLA**
    Creating SLAs computing data from server related probes.
  - **Network SLA**
    Creating SLAs computing data from network related probes.

Make your selection and click the Next button to continue.
Note the following if creating a Network SLA:

Currently the following two network probes are supported:

- `interface_traffic`
- `net_connect`

When selecting source in the wizard, it means:

- The robot hosting the probe for the `net_connect` probe.
- The device (e.g., a router) for the `interface_traffic` probe.
In this example we describe a Server SLA.
Click the Next button to continue.

- Step 1 prompts you for the following information:

- **Group Name**
  This will be the name of the created SLA group.

- **Description**
  This is a short informative description of the SLA. This information will be displayed in the Description field of each of the SLAs created through this wizard.

- **Account**
  Select the Account under which the SLA Group is to be created.

- **Select Compliance percentage, Compliance period, QoS calculation method and QoS Operating Period** as described in
the chapter *Creating Service Level Agreement*.
Optionally attach the SLA to an *account*.
Click the *Next* button to continue.

- Step 2 enables you select the *cdm* properties for the SLAs. You can select:

  - If you want to include CPU usage, Memory usage and Disk usage.
  - Which disks to include?
  - If you want to completely skip the *cdm* part (selecting *Do not include*).

Click the *Next* button to continue.
- Step 3 enables you select the `ntservices` properties for the SLAs. You can select:

  - One or more of the services listed.
  - If you want to completely skip the `services` part.

Click the *Next* button to continue.
- Step 4 enables you select the processes properties for the SLAs. You can select:

![Create SLA By Service dialog]

- One or more of the processes listed.
- If you want to completely skip the processes part.

Click the Next button to continue.

- Finally you can select one or more QoS Source. One SLA will be created for each of the selected QoS sources, and the SLAs will be placed in the SLA group created with the name specified in step 1.
Click the **Next** button to continue.

- The wizard is now finished. When you click the **Finish** button, the SLA group will be created with one or more SLAs, depending on your selections. Each of the SLAs contains one SLO with one or more QoS objects according to your selections.
Create SLA By Service

Final Step

The wizard will now generate a SLA group with on SLA for each selected source. This SLA contains a single SLO with one or more constrained QoS objects according to...
Example – Creating a SLA based on the selected SLA

This wizard will create a SLA, based on a SLA selected in the Navigation Pane. The underlying SLO(s) and QoS definitions for the selected SLA will be used as a template.

- Launch the wizard by selecting
  Tools > Wizards > Create SLA Based On The Selected SLA.

- Give the new SLA a name and an optionally short description. The SLA Description field will initially contain the description of the SLA that we use as basis for the new SLA. The Based on field will contain the name of the SLA you have selected to use as a template.

Select an account from the drop-down list at the bottom of the dialog if you want to attach the new SLA to an account, otherwise leave the field empty.

Click the Next button to continue.
The next dialogs ask you to choose a source and a target for all of the QoS definitions defined for the template SLA. Select your definitions (note that you may skip one or more QoS objects for the new SLA by checking the *Skip this QoS object* option).
Click the Next button to continue.

- When all QoS objects are defined, the following dialog appears:
Click the Finish button, and the newly defined SLA will appear in the Navigation Pane.

If the new SLA is based on a SLA in a SLA group, the new SLA will be placed in the same group.

Creating a QoS Monitoring Profile

The possibility to create monitoring profiles that are based on QoS data instead of live information from a system the way a normal probe works was introduced in SLM version 4.30.

The feature will be activated and visible, provided that the qos_engine probe is installed. For each QoS Object you will be allowed to create one or more monitoring profiles of same or different types.

A dedicated probe (the qos_engine) will subscribe to QoS messages, each QoS message will be checked to see if it fits a monitoring profile (a QoS can match to more than one profile). If one or more profiles match the incoming QoS message, the values are evaluated and alarms issued if a threshold violation is detected.

Creating and configuring monitoring profiles can be done by clicking icon beside a QoS object and selecting Create Monitor option under the QoS node in the Navigation pane.
The QoS Monitor dialog pops up, enabling you to set the monitoring properties.
Baseline Value Definition

The baseline value is a central element for the threshold when creating monitors of type Dynamic.

The baseline is calculated from measurements collected at a specific time each day for the last N days or a specific time for the same weekday the last N weeks.

All the samples within all the time spans are used to calculate the average and standard deviation of those values. This gives some fundamental values that can be used for further calculations.

An example would be: a weekly baseline definition that is set to 4 weeks and with time span 1 hour. The QoS arrives at a Friday 13:00:00; this will with a sample rate at 5 min give us 12 samples for each of the previous 4 Fridays between 12:30 and 13:30. Those 48 samples will be the basis for the baseline calculation.
QoS Monitors List

Selecting Tools > QoS Monitors in the SLM Menu bar, the QoS Monitors window will be launched. This window lists the QoS Monitors defined (if any).

QoS monitors are created as described in the section Creating a QoS Monitor Profiles.

See also the section QoS Monitor Properties for details.

Click icon in the list which gives you the possibility to:

- Edit the properties for the selected QoS monitor (see QoS Monitor Properties).
- Delete QoS monitors.
- View the baseline values for the selected monitor (see Baseline Value Definition).
QoS Monitor Properties

Monitor Name

The monitor name is automatically filled in, based on the QoS name, source and target. This name may be overruled by a name of your own choice.

Monitor Subsystem

This field is automatically filled in with the sub-system ID for the device, identifying from which part which part of the system the QoS and alarms come. The sub-system IDs are maintained by the Nimsoft Alarm Server (nas).

Monitor Types

Select a monitor type to be used as a basis for the threshold calculation. Your choice here depends on what you want to achieve:
Static
Use Static if you want alarms to be issued if the QoS value exceeds the threshold specified.

You may specify the threshold as an absolute value or as a percentage of the maximum value (maximum value is only available for QoS types with maximum size, otherwise grayed out). You may also select that at least $n$ consecutive breaches must occur before an alarm will be issued.

Dynamic
Use Dynamic if you for example want to consider that the QoS values have a regular fluctuation, such as high during the work hours and low at night.

Alarms will be issued if the QoS value exceeds the threshold, calculated from the baseline value.

You must specify Period Type, Periods and Timespan to find the baseline value, which will be used to calculate the error threshold.

- **Period Type** is day or week.
- **Periods** are numbers, defining how many days or weeks to be used to calculate the Baseline.
- **Timespan** is the time window within each period, from which samples should be used to calculate the Baseline value.

The baseline is calculated from measurements collected **at a specific time each day for the last N days or a specific time for the same weekday the last N weeks**.

The threshold is defined as an expression that is calculated in a Lua script. The expression can contain the following variables that are calculated based on the baseline settings:

- AVG
- STDEV
- MIN
- MAX
- COUNT
**Example:**

<table>
<thead>
<tr>
<th>Period Type</th>
<th>Day</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periods</td>
<td>4</td>
</tr>
<tr>
<td>Timespan</td>
<td>1 hour</td>
</tr>
</tbody>
</table>

A sample collected at for example 12.15 o’clock, will be compared with the threshold, which is calculated from the *Baseline* value. The Baseline value will be calculated based on the average value of the samples collected within the timespan (1 hour) for the four past days.

The threshold can be by either selecting one of the formulas in the drop-down list, such as 20% Above Baseline. Selecting *Custom*, you may specify a threshold manually.

**Percentile**

As for Dynamic (see above), you may use *Percentile* if you for example want to consider that the QoS values have regular fluctuations.

Alarms will be issued if the QoS value exceeds the threshold, which is a percentile of the values of the samples collected within the time spans for the periods specified.
The threshold can be specified as for example greater than the 95 percentile of the calculated value.

**Alarm thresholds:**

Error thresholds must be defined for the QoS monitors in order to have alarm messages issued on threshold breaches.

For monitors configured to use monitor type Static and Dynamic, it is also possible to define a warning threshold, and you may also select to monitor for unavailable data.

The operands available to be used to set the error- and warning thresholds are:

- Less Than
- Less Than Or Equals To
- Equals to
- Greater Than
- Greater Than Or Equals To
Threshold values

- Custom
  Selecting Custom, you can compose your own threshold value. If first selecting one of the predefined threshold values, and then selecting Custom

- Baseline
  The baseline is calculated from measurements collected at a specific time each day for the last N days or a specific time for the same weekday the last N weeks.

- 10 % Above Baseline
- 20 % Above Baseline
- Baseline + Standard Deviation
- Baseline + 20 % of Stdev
- Baseline Period Minimum
- Baseline Period Maximum

The alarm message text can contain some variables that will be expanded before the alarm is sent. The following variables are supported:

- NAME
- MONID
- VALUE
- OPERATOR
- THRESHOLD
- AVG (dynamic)
- STDEV (dynamic)
- MIN (dynamic)
- MAX (dynamic)
- COUNT (dynamic)

A typical alarm message example would be: $NAME has breached the threshold value ($THRESHOLD)
Viewing the Quality of Service (QoS) Data

The navigation window contains the **Quality of Service** node. All registered QoS objects are listed under this node using the *description* field in the QoS object. This view enables the user to quickly browse the database for particular data-series.

The structure is organized like illustrated below:

- Quality of Service
  - Quality of Service object name
    - Source
      - Target

**Note:**
This is the structure if the QoS objects are ordered on the QoS name. Clicking the icon beside QoS node in the *Navigation Pane* lets you select another sorting key, such as *order by QoS group*, where the QoS objects will be grouped into logical groups.
Let's explain the structure using "real" data. The cdm probe provides the QoS data registers the QoS objects it will use during the startup sequence. These messages are collected by the Data Engine and transformed into database tables and definitions. The cdm probe will, on a timed interval, send its QoS data, based on its findings and calculations to the Data Engine as messages (subject: QOS_MESSAGE).

This will populate the database tables matching the cdm QoS configuration. Let's say we configured the cdm to send QoS on CPU usage and Disk usage (C:) data. You are now able to browse the data using the Service Level Manager. Find the Quality of Service node and double-click to expand it. This brings up the QoS descriptions registered by the Data Engine. Find the Disk Usage node and double-click to expand it. The children nodes will reflect the sources (Robots) that are generating the QoS data. The target node holds the last piece of information needed to pinpoint the recorded data in the database, in this case e.g. C:\. We can address each QoS using the QoS-Name, Source and Target.

**Generating a Graph**

The Service Level Manager generates a graph when double-clicking a QoS objects target node in the Navigation Pane.
Select Period

You may select the period from the drop down list (last day, last week etc.).

Using the field Max Value, you may also set the maximum value of the vertical axis in the graph to a proper value to compress the graph in cases where you have "peaks".
Exporting the QoS data series

You may export QoS data to a file, using the following method

- Using the Export QoS Data wizard, accessible from clicking the icon beside the respective QoS in the Database Status dialog and selecting Export Data option from the menu (see Viewing the Actual Database Usage).
  Note that this wizard may also be started, clicking the icon beside QoS constraint under the QoS node in the Navigation pane and selecting Export data.

Exporting QoS data, using Export QoS Data wizard

- Select Tools > Wizards > Export QoS Data from the menu-bar to launch the wizard.

Click the Next button to continue.
The next dialog lets you configure the QoS source and targets. (Note that the fields in this dialog are already filled in if the wizard was started from the Database Status window). Click the Next button to continue.

The next dialog lets you select which period to export. Configure the
period to select data from and click the Next button to continue.

- In next dialogue box, you can modify the column and or row separators, and you can include or exclude column headers in the formatted file.

Click the Next button to continue to the last dialog, where you click the
Finish button to finish and exit the wizard.
Two other ways to launch the Export Data wizard:

You may also launch the wizard by selecting Tools > Database Status from the menu-bar.

This will open the Database Status window, showing you various information related to the QoS data stored in your database. Click the icon beside the respective QoS in the list which opens a small menu. Selecting the Export Data option will launch the wizard.
Also clicking the icon beside the respective QoS object under the QoS node in the Navigation pane and selecting Export Data will launch the Export wizard.
Data Management

All Quality of Service data is received by the data_engine and inserted into the database. The data_engine may be configured to perform automatic clean-up procedures by defining configuring the data_management section of the data_engine.

You may, however, perform manual data-management by using the Service Level Manager.

Viewing the Actual Database Usage

Select Tools > Database Status from the menu-bar to bring up the Database Status window. This will show you various information related to the QoS data stored in your database. The tabs represent various ways of getting information regarding the database usage.
The Active Objects Tab

Shows all available QoS objects registered within the database structure. Bring up the action menu by issuing a right-mouse button-click. View the QoS data by double-clicking the list element, or perform a selective data-management by selecting delete.

- F5 - Refresh list
- F6 - Update/view sample period for the selected QoS objects.

The Sub menu

On clicking icon beside any of the QoS objects in the list opens a small menu with the following options:

- **Update**
  Updates the selected row with data from the current compliance period.

- **Get Statistics**
  Finds the details statistics like Historic Row, First Sample, Last Sample, S./Min etc. within the current compliance period.
  This information will then be found in the respective columns in the window.

- **Delete Object(s)**
  Deletes the selected QoS object(s) (not only the data series) from the database. The deleted QoS object will disappear from the database and will not be re-created before the probe is restarted.

- **Merge Objects**
  Allows you to merge two QoS objects of the same type. Left-click the first object and <ctrl>+left-click the next object. Click icon and select the merge object option.
Note that you can toggle the direction of the merge operation by clicking the arrow in the middle of the dialog. The newly merged QoS objects will take the “destination” QoS object’s name.

You also have the option to delete the “source” QoS after the merge operation. The deleted QoS object will disappear from the database and will not be re-created before the probe is restarted.

- **View Data**
  Opens the graph, displaying the data for the current compliance period.

- **Delete Data**
  Opens the Data Management dialog for the selected QoS constraint, allowing you to delete the complete QoS data series, or just for a selected period. The QoS object is not deleted selecting this option, and data for the
selected QoS constraint will continue to be stored in the database table.

- **Export Data**
  Opens the Export QoS Data wizard, enabling you to export the data series for the selected QoS constraint dialog to a file. See the section *Exporting the QoS data series*.

- **Filter by QoS**
  Selecting one entry in the list and selecting *Filter by QoS*, all entries with the same QoS as the selected one will be listed, all others will be removed from the list.
  In the example below, all entries with QOS_CPU_USAGE will be collected in a list; all others will be removed from the list.

Click the icon beside the respective QoS and select *Update* to return to the original list.
- **Filter by Source**
  Same as *Filter by QoS*, but in this case, entries with identical source will be collected in the list.

- **Filter by Target**
  Same as *Filter by QoS*, but in this case, entries with identical target will be collected in the list.

- **Filter by Host**
  Same as *Filter by QoS*, but in this case, entries with identical host will be collected in the list.

- **Filter by Robot**
  Same as *Filter by QoS*, but in this case, entries with identical robot will be collected in the list.

- **Filter by Probe**
  Same as *Filter by QoS*, but in this case, entries with identical probe will be collected in the list.

- **Filter by Origin**
  Same as *Filter by QoS*, but in this case, entries with identical origin will be collected in the list. All messages received by a given hub are stamped with an *origin* element. The default *origin* name will be the HUB name.

- **Change origin**
  Selecting one or more entries in the list, clicking the icon and selecting *Change Origin* lets you change origin for the selected entries (all messages received by a given hub is stamped with an *origin* element. The default *origin* name will be the HUB name). Available origins will be listed in the dialog popping up. You can also create a new origin by clicking the *Add* button.
The columns in the window

The followings columns appear in the window when the Active Objects tab is selected:

- **Quality of Service**
  The name of the QoS object.

- **Source**
  From where the sample originates.

- **Target**
  The target of the sample.

- **Rows**
  The number of rows in the database table containing data for the QoS Object.

- **Historic rows**
  The number of rows in the historic database table containing data for the QoS Object.

- **First sample**
  The time and date of the first sample within the current compliance period. Note that this information is made available after clicking the icon beside the entry and selecting Get Statistics option.
- **Last sample**
The time and date of the last sample within the current compliance period. Note that this information is made available after clicking the icon beside the entry and selecting *Get Statistics* option.

- **Table id**
An id number assigned to each of the QoS objects registered within the database structure.

- **S./min.**
The number of samples per minute. Note that this information is made available after clicking the icon beside the entry and selecting *Get Statistics* option.

- **Originator**
The address of the computer running the probe.

- **Host**
The IP-address of the host hosting the probe from which the sample originates.

- **Robot**
The name of the robot from which the sample originates.

- **Probe**
The name of the probe from which the sample originates.

- **Origin**
This is the origin of the QoS sample. All messages received by a given hub are stamped with an *origin* element. The default *origin* name will be the HUB name.
The QoS Probes Tab

Shows the QoS objects registered per probe. Delete the selected data-series by clicking icon and selecting Delete Data option. This operation deletes all objects matching the "host" field and the "QoS" field.

The followings columns appear in the window when the QoS Probes tab is selected:

- **Registered**
  The time the QoS object was registered in the database,

- **Host**
  The IP address of the host where the probe sending the QoS data is installed.

- **Probe**
  The name of the probe sending the QoS data.

- **Quality of Service**
  The name of the QoS object.

Information Tab

Shows information related to the database, such as:

- Database server name
- Database name
- Database version
- Database owner
- When the database was created
- Database usage
- Database location
Managing your QoS Data

Select Tools > Data Management from the menu-bar to bring up the Data Management Dialog, where you can change the period settings and delete historic data for the selected QoS constraint. The various fields in the dialog are described below:

- **Quality of Service Object**
  - **Description**
    The QoS description string.
  - **Object**
    The QoS object name.
  - **Source**
    The source of the QoS data. E.g. computer, device etc.
  - **Target**
    The target of the QoS data. E.g. the disk, network service, CPU, etc.
• **Operation**
  - Delete Data: Select this option to delete the QoS data related to the source and target settings.
  - Invalidate Data: Select this option to invalidate the QoS data related to the source and target settings.
  - Delete Historic data: Select this check box to delete the historic data for this QoS constraint.

• **Period settings**
  You can select a period, or you can select *Ignore*, which means that the measurement is not restricted to specific periods.
Watching SLA Calculations

Selecting Tools > SLA Calculations in the Menu bar opens the Service Level Calculations window, listing the current calculations for the SLAs.

A service level agreement (SLA) will automatically get recalculated for the current period by the sla_engine (on a schedule as specified in the sla_engine user interface), but you can manually recalculate a SLA by clicking icon beside desired SLA and selecting New option (see below), or clicking icon beside the SLA in the Navigation Pane and selecting Recalculate.

New
Using this option, you may manually recalculate the SLAs.

The Job properties dialog is opened, allowing you to select a SLA to be recalculated.

The time period for the report can be specified, either as a Fixed report, where you can select one or more fixed periods, or as a Custom report, where you can select a time range.
The *Job start time* specifies when the job calculation job should be started; the *Job expiration* time specifies when the job is removed from the database.

The *Create historic data* option lets you select the compliance data to be recorded/saved for historic reports, and the *Delete report when expired* will delete the report from the database when the report has expired.

SLAs are also automatically recalculated on a schedule as specified in the sla_engine user interface.

- **Delete**
  Deletes the calculations for the selected SLA from the list in the window.

- **Update**
  Updates the selected row with data from the current compliance period.

- **View**
  This option opens the compliance job description window for the selected SLA.
The columns in the window

The Service Level Calculations window contains the following columns:

- **Job Id**
  The job identification number assigned to a new job.

- **SLA**
  Shows the name of the SLA being calculated.

- **Description**
  Indicates if the calculation job runs automatically as scheduled, or if it was manually started by the administrator.

- **Period Begin**
  Displays the starting date/time of the compliance calculation period.

- **Period End**
  Displays the end date/time of the compliance calculation period.

- **Owner**
  The name of the operator that requested the calculation job.

- **Job Start**
  Defines the date/time for when the compliance calculation job should start.

- **Job Expire**
  Defines the date/time for when the job is automatically removed from the SLM system.

- **History**
  Indicates that compliance data should be recorded/saved for historic reports.
Double-clicking one of the SLAs in the window opens the *Calculated SLA Compliance job* window for that SLA.

The window displays:
- The selected Compliance period
- The name and description of the SLA
- The Status, with the expected and the achieved value.
- The SLOs, listed in the lower left corner.
- The QoS constraints, listed in the lower right corner, supplying the following information:
  - The name of the QoS object.
  - The name of the source computer.
  - The name of the target computer.
  - The achieved compliance.
  - The expected compliance.
  - The total number of samples.

Double-clicking one of the QoS constraints brings up the QoS graph (also see the section Generating Graph).
Sending SQL Queries to the database

Selecting the Tool > SQL Query option from the Menu Bar opens the SQL Query dialog. This function can be used to query the database directly, and is useful for testing- and verification purposes.

**Warning:**
This function should be used by experienced users only.

Here you can select a query from the combo box, and the query is sent to the database by clicking the *Start query* button.

The result of the query will be presented in a table under the *Recordset* tab. The number of rows found is also displayed on the tab header.

Note that you may run multiple queries simultaneously by typing queries in the list in addition to the one selected from the combo box. Clicking the *Start query* button will run all queries in the list.

If selecting (highlighting) one of the queries in the list, just that query will be run when clicking the *Start query* button.

Note that a started and running query can be stopped, using the *Stop query* button.
Chapter 5: Appendix

SLM Terms and definitions

Automatic (Interval) data type

QoS Data is recorded at intervals, individually specified in the probe configuration for each of the probes.

Asynchronous data type

QoS Data is recorded each time the measured value changes.

Calculation method

Calculation method is the set of rules and conditions determining the way the SLA compliance is calculated.

Compliance period

The compliance period defines the period of time that the SLA should meet the requirements stated by the compliance percentage, typically a day, a week or a month.

The illustration shows the relationship between the operating period and the compliance period.

The gray area illustrates the compliance period, and the blue area illustrates an operating period with 5 time-specifications.

Example:

Let's say that the compliance period (gray area) is defined to be one week (Monday to Monday). Our requirements for the SLA are defined to be between 08:00 and 17:00 every weekday (operating period). Notice that the data (blue plot) within the operating periods (blue area) are included in the SLA computations.
Compliance percentage

The compliance percentage is defined to be the percentage of time that the QoS, constrained by e.g. operating period and thresholds, should be considered compliant within the compliance period.

Each sample is checked within the compliance period by the \textit{data_engine} and summarized as \textbf{failed} or \textbf{successful}. The result is compared against the expected compliance percentage (defined by the user).

Consider the data represented by the illustration. The \textbf{red} line represents the threshold value, the \textbf{green} line represents the average value and the \textbf{blue} line represents the actual sample values.

How many samples within the operating period are above the threshold settings?

Zero samples breach the threshold line within the operating periods, thus fulfilling 100% of our compliance requirements. The 5 samples that breach the threshold are outside the compliance period which was e.g. Monday to Monday, with operating periods every weekday from 08:00 to 17:00.
Let’s assume that the total number of samples within the operating period is 129, with 9 samples breaching the threshold. This implies that 6.98% of the samples are accounted for as **out of compliance** (9 * 100/129).

If our Service Level Agreement requires a compliance of 98.50% (or better) and the only data defined in this SLA is the above data, then our requirements to the SLA is **breached** due to a current compliance percentage of 100% - 6.98% = 93.02%.

**Data Types**

We use the following different data types when calculating the compliance:

- **Automatic (Interval)**
  QoS Data is recorded at intervals, individually specified in the probe configuration for each of the probes.

- **Asynchronous**
  QoS Data is recorded each time the measured value changes.
Domain

The Domain is the top-level node in the hierarchy, and a site is normally set up with one Domain. It is used to group one or more Hubs in a logical set such as a company or enterprise.

Hub

The Hub is a message concentrator and re-distributor. It is the collection point for all messages coming from the various installed Robots. Many other Nimsoft components can connect to the Hub to receive dedicated messages and perform other specific activities. One such component is the Alarm server.

NULL value

A NULL value will be recorded into the database typically if a probe does not measure a value from the target due to a timeout, e.g. no answer to a ping). In the QoS Calculation Profiles, available under the Calculation Profiles Node in the Navigation Pane of the SLM, you may define how these NULL values are handled in a compliance calculation.

Operating period

The operating period constrains the QoS samples to one or more time-specifications within the compliance period. This means that samples falling outside these time specifications will not influence the SLO/SLA compliance requirements. Each operating period is defined as a union of one or more time-specifications.

Probes

Probes are small dedicated pieces of software that monitor specific resources or events. Each probe can be easily configured for your own specific monitoring requirements.

Robot

The Robot is the first line of management for the Probes. The Robot starts and stops the probes at the required times, collects, queues and forwards messages from the probes onto the specified Hub.
Service Level Agreement (SLA)

A Service Level Agreement (SLA) is an agreement to deliver a service within a specified/fixed time-period to an extent where both parties agree on a measurable service levels. The parties may be an IT department delivering services to another department within the company, or by a company and an external service provider.

The services included in the SLA may be a collection of monitored objectives we call Service Level Objectives (SLO). These objectives (or group of objectives) are monitored by dedicated programs (often standard probes) that monitor e.g. network connectivity, application (Oracle, Exchange, e-mail) availability and service (DNS, DHCP) availability.

SLO

A Service Level Objective (SLO) is a combination of one or more component measurements (Quality of Service) to which constraints are applied. A SLO is said to be in compliance if the underlying measurement values are within the specified constraints. SLO’s may have operating periods during which the SLO has to be compliant.

SLM

The Service Level Manager (SLM) is the application where service level configuration and monitoring is performed. The application needs a valid license to operate.

QoS

The Quality of Service (QoS) is the atom of the Service Level Management. The QoS is the actual value (sample) collected and used centrally to determine the state of the service level objective. This value is normally collected by a probe like cdm, net_connect, url_response etc. The value is first used for alarm purposes, but if the probe is configured to deliver Quality of Service, then a QoS message is issued.

A QoS constrained by threshold, source, target and operating period settings is used as the building blocks for SLO's.

QoS object
The QoS object is defined by its **QoS name**, **source** and **target**. All sample-data with this unique combination form data-series that may be used as part of any Service Level Objective.

**QoS constraint**

A constrained QoS object is defined by its **QoS name**, **source**, **target**, **threshold** and **operating period**. This constrained object is the building block of the Service Level Objective.
Index

A
account, 114
Add Exclude Period wizard, 101
Asynchronous data type, 94
Automatic data type, 94
Average, 92

C
calculation jobs, 22
calculation jobs, started manually, 22
Calculation method Default, 25
Calculation multi-series, 27, 30
Calculation Profiles, 91
chm file, 7
Compliance job scheduling, 22
Compliance percentage, 22

D
Data collection, 11
Data Collection, 12
Data Engine, 18
Data repository, 11
Data Repository, 12
Data Series, 94
Data transport, 11
Data Transport, 12
Database, 15
Database tables, 15
Default calculation method, 25
define a new SLA group, 46

F
Filter, 143
Filter by QoS, 143
Filter by Source, 144
Filter by Target, 144

G
Grouping QoS objects in folders, 43

I
Interval, 93

M
Median, 93
multi-series Calculation, 30

N
NULL value, 92, 158

O
Operating periods, 50
organize, 43
organizing QoS objects, 43
organizing QoS objects, 43

Q
QoS, 9
QoS data structure, 16
QoS data tables, 16
QoS objects, organizing, 43
QOS_DEFINITION, 16

S
schedule, 22
scheduling compliance jobs, 22
Service-level management, 9
SLA, 9
SLA calculation tables, 17
SLA configuration tables, 17
SLA wizards, 40
SLM, 9
SLM database, 15
SLM Overview, 11
SLO, 9
<table>
<thead>
<tr>
<th>T</th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables QoS data, 16</td>
<td>wizard, 102</td>
</tr>
<tr>
<td>Tables SLA calculation, 17</td>
<td><em>Wizards</em>, 40</td>
</tr>
<tr>
<td>Tables SLA configuration, 17</td>
<td><em>Wizards SLA</em>, 40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>U</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Using multi-series Calculation Profiles, 30</td>
<td></td>
</tr>
</tbody>
</table>